Clinical Flow Sheet CliO V2
Implementation Guide

MD*1.0*42
March 2016

Department of Veterans Affairs
Office of Information & Technology (OI&T)
Product Development
This page intentionally left blank for double-sided printing
## Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
<th>Authors</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>April 2011</td>
<td>Patch MD<em>1</em>16 Released</td>
<td>REDACTED</td>
<td></td>
</tr>
<tr>
<td>April 2011</td>
<td>Added note in section 6.2 regarding legacy devices</td>
<td>REDACTED</td>
<td></td>
</tr>
<tr>
<td>July 2011</td>
<td>Added note about TIU Note Title for Reporting field to section 5.1, step 4.</td>
<td>REDACTED</td>
<td></td>
</tr>
<tr>
<td>July 2011</td>
<td>Section 5.1, Adding a New Flowsheet: added new step 4 after note, revised step 5.</td>
<td>REDACTED</td>
<td></td>
</tr>
<tr>
<td>July 2011</td>
<td>Section 5.3.1, Understanding Totals Display, changed “median” of all observations to “average “ of all observations.</td>
<td>REDACTED</td>
<td></td>
</tr>
<tr>
<td>July 2011</td>
<td>Section 5.2, Creating a Flowsheet Total, replaced figure 5-10, Totals Display from CP Flowsheets. Section 4.1, Importing Views from XML, replaced MD1_0P16_Default_Views.xml with MD1_0P16_Sample_Views.xml. Removed section 5.4.2, Changing the Schedule for a Task.</td>
<td>REDACTED</td>
<td></td>
</tr>
<tr>
<td>December 2011</td>
<td>Added note and graphic to step 4 of Section 4.2.7, Modifying Terms in a View. Added new section 3.1.2.3 CP Console Folder View Permissions. Added note to section 3.1.2.8 Export to XML. Added note to section 4.1 Importing Views from XML.</td>
<td>REDACTED</td>
<td></td>
</tr>
<tr>
<td>January 2012</td>
<td>Deleted sections 3.1.2.4, 3.1.2.5 and 3.1.2.6 and edited section 3.2.1.3 to update Folder View Permissions. Added sections 6.2.1.1 and 6.6.2.1 describing Make Copy for Instruments and Procedures.</td>
<td>REDACTED</td>
<td></td>
</tr>
<tr>
<td>March 2016</td>
<td>Patch MD<em>1.0</em>42: Added Section 6.2.4.1, Configuring a Bi-Directional Instrument to Receive Data Only (page 64).</td>
<td>REDACTED</td>
<td></td>
</tr>
</tbody>
</table>
This page intentionally left blank for double-sided printing
Table of Contents

1. Introduction ........................................................................................................................................... 1
   1.1. Implementation Guide ................................................................................................................ 1
   1.2. Product Benefits ...................................................................................................................... 1
   1.2.1. CP Gateway Service ........................................................................................................ 1
   1.2.2. CliO Database ...................................................................................................................... 2
   1.2.3. Terminology Mapping ........................................................................................................ 2
   1.3. CP Flowsheets .......................................................................................................................... 3
   1.4. CP Console ............................................................................................................................ 3
   1.5. Intended Audience .................................................................................................................... 3
   1.6. CP Console Implementation .................................................................................................... 3

2. Pre-Implementation Planning ................................................................................................................. 4
   2.1. General Guidance .................................................................................................................... 4
   2.2. Software ....................................................................................................................................... 4
   2.3. Flowsheet Design ..................................................................................................................... 6
   2.4. Flowsheet Coordinators .......................................................................................................... 6
   2.5. Contingency Plans .................................................................................................................... 6

3. CP Console Overview ............................................................................................................................. 7
   3.1. CP Console Menu Bar ............................................................................................................... 8
   3.1.1. File Menu ............................................................................................................................. 8
   3.1.1.1. New Menu ....................................................................................................................... 9
   3.1.1.2. Renaming an Item in the Tree View .............................................................................. 10
   3.1.1.3. Deleting an Item ............................................................................................................. 10
   3.1.2. Tools Menu ......................................................................................................................... 11
   3.1.2.1. Search ............................................................................................................................. 11
   3.1.2.2. Working with User Permissions ..................................................................................... 12
   3.1.2.3. CP Console Folder View Permissions .......................................................................... 13
   3.1.2.4. Refresh Roles .................................................................................................................. 14
   3.1.2.5. Export to XML ............................................................................................................... 15
   3.1.2.6. Import from XML ........................................................................................................... 18
   3.1.3. Help Menu .......................................................................................................................... 19
   3.2. CP Console Tree View ............................................................................................................... 19
   3.3. CP Console Detail Area ............................................................................................................. 20

4. Working with Clinical Flowsheet Views ................................................................................................. 22
   4.1. Importing Views from XML ...................................................................................................... 23
   4.2. Customizing Flowsheet Views .................................................................................................... 27
   4.2.1. Making a Copy ..................................................................................................................... 28
   4.2.1.1. Renaming a Copied View ............................................................................................ 29
   4.2.1.2. Protecting an Imported or Exported View ................................................................... 31
   4.2.2. Creating a New Flowsheet View ......................................................................................... 32
   4.2.3. View Terminology Editor .................................................................................................. 34
   4.2.4. Adding Terms to a View ..................................................................................................... 35
   4.2.4.1. Term Definitions ............................................................................................................ 36
   4.2.5. Working with Qualifiers ..................................................................................................... 37
   4.2.6. Changing the Display Order of Terms in a View ............................................................... 38
   4.2.7. Modifying Terms in a View ............................................................................................... 38
   4.2.8. Removing Terms from a View ............................................................................................ 40
5. Creating Flowsheets in CP Console..................................................................................................... 42
  5.1. Adding a new Flowsheet ............................................................................................................... 43
    5.1.1. Adding a View to a Flowsheet ............................................................................................... 44
    5.1.2. Pages Tab ............................................................................................................................. 45
    5.1.3. Editing a View Type in a Flowsheet ..................................................................................... 46
    5.1.4. Removing a View from a Flowsheet .................................................................................. 47
    5.1.5. Changing the Display Order of Views in a Flowsheet ....................................................... 47
  5.2. Creating a Flowsheet Total .......................................................................................................... 48
    5.2.1. Editing the Flowsheet Total ............................................................................................... 50
      5.2.1.1. Terminology Section ...................................................................................................... 50
    5.2.2. Totals Tab ........................................................................................................................... 51
      5.2.2.1. Adding Totals to a Flowsheet ....................................................................................... 51
      5.2.2.2. Removing Totals from a Flowsheet ............................................................................ 52
      5.2.2.3. Changing the Display Order of Totals in a Flowsheet ............................................... 52
  5.3. Flowsheet Total ............................................................................................................................ 52
    5.3.1. Understanding Totals Display ............................................................................................. 53
  5.4. Setting up Default Shifts .............................................................................................................. 54
    5.4.1.1. Shift Information Definitions ....................................................................................... 54
    5.4.1.2. Adding a Shift .............................................................................................................. 54
    5.4.1.3. Modifying an Existing Shift .......................................................................................... 55
  5.4.1.4. Adding a new Shift ......................................................................................................... 57
  5.4.2. Removing a Shift .................................................................................................................... 57
  5.5. Flowsheet Management .............................................................................................................. 58
    5.5.1. Adding a View to a Flowsheet ........................................................................................... 59
    5.5.2. Removing a View from a Flowsheet .................................................................................. 60
    5.5.3. Editing a View Type in a Flowsheet .................................................................................. 61
    5.5.4. Changing the Display Order of Views in a Flowsheet ..................................................... 62
  5.6. Flowsheet Backup ........................................................................................................................ 63
    5.6.1. CliO Backup ...................................................................................................................... 63
    5.6.2. CP Backup ......................................................................................................................... 64
    5.6.3. HL7 Backup ....................................................................................................................... 65
  5.7. Flowsheet Restore ........................................................................................................................ 66
    5.7.1. CliO Restore ...................................................................................................................... 66
    5.7.2. CP Restore ......................................................................................................................... 67
    5.7.3. HL7 Restore ....................................................................................................................... 68
  5.8. Flowsheet Export ........................................................................................................................... 69
    5.8.1. CliO Export ...................................................................................................................... 69
    5.8.2. CP Export ......................................................................................................................... 70
    5.8.3. HL7 Export ....................................................................................................................... 71
  5.9. Flowsheet Import .......................................................................................................................... 72
    5.9.1. CliO Import ...................................................................................................................... 72
    5.9.2. CP Import ......................................................................................................................... 73
    5.9.3. HL7 Import ....................................................................................................................... 74
  5.10. Flowsheet Management ............................................................................................................. 75
    5.10.1. Adding a View to a Flowsheet ....................................................................................... 75
    5.10.2. Removing a View from a Flowsheet ............................................................................. 76
    5.10.3. Editing a View Type in a Flowsheet ............................................................................... 77
    5.10.4. Changing the Display Order of Views in a Flowsheet ................................................... 78
  5.11. Flowsheet Configuration ............................................................................................................ 79
    5.11.1. Terminology Section ...................................................................................................... 79
    5.11.2. Parameters .................................................................................................................... 80
    5.11.3. ADT Targets ................................................................................................................... 81
    5.11.4. Procedure Definitions ................................................................................................... 82
    5.11.5. Procedure Worksheet ................................................................................................... 83
    5.11.6. Instrument Definitions .................................................................................................. 84
    5.11.7. Attachment Processing ................................................................................................ 85
    5.11.8. Bi-Directional Instrument ......................................................................................... 86
    5.11.9. Allowable Instruments ................................................................................................. 87
    5.11.10. Procedure Worksheet ................................................................................................. 88
  5.12. Flowsheet Total .......................................................................................................................... 89
    5.12.1. Adding Totals to a Flowsheet ....................................................................................... 90
    5.12.2. Removing Totals from a Flowsheet ............................................................................ 91
    5.12.3. Changing the Display Order of Totals in a Flowsheet ................................................ 92
  5.13. Flowsheet Backup ...................................................................................................................... 93
    5.13.1. CliO Backup ................................................................................................................... 93
    5.13.2. CP Backup .................................................................................................................... 94
    5.13.3. HL7 Backup .................................................................................................................. 95
  5.14. Flowsheet Restore ...................................................................................................................... 96
    5.14.2. CP Restore ................................................................................................................. 97
    5.14.3. HL7 Restore .............................................................................................................. 98
  5.15. Flowsheet Export ....................................................................................................................... 99
    5.15.1. CliO Export ................................................................................................................... 99
    5.15.2. CP Export .................................................................................................................... 100
    5.15.3. HL7 Export ............................................................................................................... 101
  5.16. Flowsheet Import ....................................................................................................................... 102
    5.16.1. CliO Import ................................................................................................................ 102
    5.16.2. CP Import ..................................................................................................................... 103
    5.16.3. HL7 Import ............................................................................................................... 104
  5.17. Flowsheet Management .............................................................................................................. 105
    5.17.1. Adding a View to a Flowsheet ....................................................................................... 105
    5.17.2. Removing a View from a Flowsheet ............................................................................. 106
    5.17.3. Editing a View Type in a Flowsheet ............................................................................... 107
    5.17.4. Changing the Display Order of Views in a Flowsheet .................................................. 108
  5.18. Flowsheet Configuration ............................................................................................................ 109
    5.18.1. Terminology Section ...................................................................................................... 109
    5.18.2. Parameters .................................................................................................................... 110
    5.18.3. ADT Targets ................................................................................................................... 111
    5.18.4. Procedure Definitions ................................................................................................... 112
    5.18.5. Procedure Worksheet ................................................................................................... 113
    5.18.6. Instrument Definitions .................................................................................................. 114
    5.18.7. Attachment Processing ................................................................................................ 115
    5.18.8. Bi-Directional Instrument ......................................................................................... 116
    5.18.9. Allowable Instruments ................................................................................................. 117
    5.18.10. Procedure Worksheet ................................................................................................. 118
  5.19. Flowsheet Total .......................................................................................................................... 119
    5.19.1. Adding Totals to a Flowsheet ....................................................................................... 120
    5.19.2. Removing Totals from a Flowsheet ............................................................................ 121
    5.19.3. Changing the Display Order of Totals in a Flowsheet ................................................ 122
  6. Additional Flowsheet Tasks .............................................................................................................. 57
  6.1. Setting up Background Tasks ...................................................................................................... 57
    6.1.1. CliO Cleanup .................................................................................................................. 58
    6.1.2. CP Cleanup ................................................................................................................... 58
    6.1.3. HL7 Cleanup ................................................................................................................... 58
  6.2. Adding an Instrument .................................................................................................................... 59
    6.2.1. Modifying an Existing Instrument ................................................................................... 60
      6.2.1.1. Using Make Copy for Instruments .......................................................................... 61
      6.2.1.2. Renaming a Copied Instrument .............................................................................. 62
    6.2.2. Instrument Definitions .................................................................................................... 62
    6.2.3. Attachment Processing ..................................................................................................... 63
    6.2.4. Adding a Configuration for a Bi-Directional Instrument ............................................... 63
      6.2.4.1. Configuring a Bi-Directional Instrument to Receive Data Only .................................. 64
  6.3. Working with Parameters .............................................................................................................. 65
    6.3.1. CP Parameters ................................................................................................................ 65
    6.3.2. Administering Notification Lists ....................................................................................... 66
  6.4. CP ADT Feed Configuration ........................................................................................................ 67
    6.4.1. Current ADT Targets ....................................................................................................... 68
    6.4.2. Adding an ADT Target ................................................................................................... 68
  6.5. CP Gateway Service Configuration .............................................................................................. 69
    6.5.1. VistA Server Settings ....................................................................................................... 70
    6.5.2. Gateway Server Settings ............................................................................................... 70
  6.6. Working with Procedure Information .......................................................................................... 71
    6.6.1. Adding a Procedure ........................................................................................................... 72
    6.6.2. Modifying an Existing Procedure ..................................................................................... 73
      6.6.2.1. Using Make Copy for Procedures ........................................................................... 74
      6.6.2.2. Renaming a Procedure ........................................................................................... 75
    6.6.3. Procedure Definitions ....................................................................................................... 76
    6.6.4. Allowable Instruments ...................................................................................................... 77
    6.6.5. Working with the Procedure Worksheet ............................................................................. 77
1. Introduction

1.1. Implementation Guide

The Implementation Guide provides technical information for the implementation of the Clinical Procedures Flowsheets Module. This document provides guidance for Information Resource Management (IRM) technical personnel, Clinical Application Coordinators (CACs), and Flowsheet Coordinators to implement and operate the software. More information can be found in the Clinical Procedures (CP) V1.0 Flowsheets Module User Manual.

1.2. Product Benefits

The Clinical Flowsheets patch of the Clinical Procedures (CP) package provides an electronic representation of the traditional paper flowsheet maintained during each inpatient stay. Vitals, Intake/Output, and Wound Documentation are examples of data types that can be recorded via Clinical Flowsheets into the Veterans Health Information System and Technology Architecture (VistA) system. Clinical Flowsheets provides a departure from its predecessor applications by storing collected information as discrete data. Some data elements, such as vital signs, are available to the Vitals Package and Computerized Patient Record System (CPRS). Various reports built on the other data elements are available for CPRS in the form of Text Integration Utilities (TIU) Notes. Additionally, flowsheets is a tool that can be used by clinicians to standardize assessment templates.

There are two ways to enter data into Clinical Flowsheets: manually and via Health Level 7 (HL7) messaging. Any instrument or external system capable of sending HL7 messages can be considered a source of data for Clinical Flowsheets (provided that the HL7 messages conform to Clinical Flowsheets requirements).

Clinical Flowsheets uses VistA Data Extraction Framework (VDEF) support, HL7 messaging, and the CP Gateway service to notify the medical device of the patient’s admission, discharge, and transfer.

MD*1.0*16 consists of the following three windows executables components and one Kernel Installation & Distribution System (KIDS) build:

- CPConsole.exe
- CPFlowsheets.exe
- CPGatewayService.exe
- MD1_0P16.KID

1.2.1. CP Gateway Service

The CP Gateway Service is the component that processes HL7 messages.

The CP Gateway Service is composed of two subsystems, one existing solely within VistA, and the other existing as a Windows service that interacts with VistA via the Remote Procedure Call (RPC) Broker. A vendor device sends an observation to VistA inside an HL7 (ORU^R01) inbound message. The message is received by the VistA HL7 system, the patient and device are validated, and it is then forwarded to the Windows-based CP Gateway Service subsystem.
The VistA CP Gateway Service subsystem parses and validates the patient-identifying information and the device identifier. If the patient information and device identifiers are valid, the Windows service is notified that there is a message waiting to be processed in VistA. The Windows service calls into VistA via the RPC Broker to retrieve the HL7 message. The Windows service then parses and validates the observation data and saves the validated information in the Clinical Observations database (CliO) data store.

A Microsoft Windows service was used so that, in the next iteration of CliO, it will be possible to build in the ability to parse and decode images encoded in HL7 messages. Using a Microsoft Windows service also allows the processing of observational data to be offloaded to a second processor, allowing the primary listening process in the HL7 subsystem in VistA to be more responsive.

![Diagram](image)

**Figure 1-1 CP Gateway Service**

For more information about the CP Gateway Service, refer to the *CP V1.0 Flowsheets Module Installation Guide*.

### 1.2.2. CliO Database

The CliO database provides a standardized terminology data store for all clinical observations throughout the Department of Veterans Affairs (VA).

### 1.2.3. Terminology Mapping

The CP Gateway Service provides extensive terminology mapping which translates proprietary labels so the information is understood to represent the same thing and, thus, be stored appropriately. Devices do not always use the same terms to describe the data they transmit. For example, one device may use the term “heart rate,” while another may transmit the same information as “pulse.” This mapping is more efficient than trying to compel each medical device vendor to conform to using standard terminology.

Similarly, CP Flowsheets can display the data to the user using the terminology that is preferred at a given unit or medical center. A flowsheet used by an MICU unit at one hospital can be customized to display “Heart Rate,” while a flowsheet used by a step-down unit may display “HR” or “Pulse.”
1.3. CP Flowsheets

CP Flowsheets provides an electronic representation of the traditional paper flowsheet. This user-friendly, customizable Graphical User Interface (GUI) provides functionality for data entry, validation and editing, as well as patient management.

- Flowsheets provides electronic flowsheets that can be custom designed for any clinical area of a Medical Center.
- Flowsheets is a tool that can be used by clinicians to standardize assessment templates nationwide.
- Flowsheets provides the ability to report discreet observations data combined with progress notes.
- Flowsheets creates a complete audit trail of patient documentation.

1.4. CP Console

CP Console provides the tools to build the flowsheet views and layouts that are used for patient care, for recording vital statistics as necessary. It also provides a means for configuring the CP Gateway Service, assigning permissions to CP Flowsheets users, and system administration.

1.5. Intended Audience

This Implementation Guide is intended for use by Information Resource Support personnel, CACs, and Flowsheet Coordinators. End users should be familiar with the following:

- Windows operating systems
- CPRS functionality

1.6. CP Console Implementation

CP Console is the administration dashboard for implementing and maintaining Clinical Flowsheets and devices for Clinical Procedures. Information Resource Management (IRM) should grant the site’s flowsheet coordinator the MD ADMINISTRATOR key. CP Console is then used to set up views, flowsheets, flowsheet totals, instruments, shifts, scheduled cleanup of unused files, and all the other administrative tasks to customize the application for their site.
2. Pre-Implementation Planning

2.1. General Guidance

To begin the pre-implementation planning, it is recommended that Medical Center Management support a Clinical Flowsheets Focus Group comprised of representatives from the Chief of Staff’s office, IRM, Nursing, Labor Management, Quality Management, Health Information Management Service (HIMS) and Biomedical Engineering. The focus group would discuss the order of implementation in the facility, new process and procedures for documenting using electronic flowsheets, as well as the third party vendor devices, such as bedside monitors and Clinical Information Systems that may be used in/purchased for Critical Care areas. Additionally, this group would drive the design of the flowsheets as this is site configurable.

This software can be implemented one unit at a time. As with any new software, new processes and procedures are required. For Clinical Flowsheets to be effective and successful, all transactions need to be entered and documented electronically.

IMPORTANT: Installation of MD*1.0*16 and MD*1.0*12 are a prerequisite for MD*1.0*23. Content in this document is based on the assumption that you already have MD*1.0*16 installed. In addition, installation of MD*1.0*23 is mandatory for all sites that are implementing CP Flowsheets.

2.2. Software

The CP Clinical Flowsheets product, MD*1*16, was released with the following components:

<table>
<thead>
<tr>
<th>File Name</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>MD1_P16.KID</td>
<td>MD<em>1.0</em>16 KIDS Build</td>
</tr>
<tr>
<td>MD1_0P16_Sample_Views.xml</td>
<td>Sample Views</td>
</tr>
<tr>
<td>MD1_0P16CPGatewayServiceSetup.exe</td>
<td>MD<em>1.0</em>16 CP Gateway Service setup file</td>
</tr>
<tr>
<td>MD1_0P16_EXES_AND_DOC.zip</td>
<td>12 files indented below</td>
</tr>
</tbody>
</table>

- CliO_Terminology.doc | MD*1.0*16 Clinical Flowsheets Terminology file |
- CPConsole.cnt | MD*1.0*16 CP Console online Help contents file |
- CPConsole.exe | MD*1.0*16 CP Console Executable |
- CPConsole.hlp | MD*1.0*16 CP Console online Help file |
- CPGatewayService.exe | MD*1.0*16 CP Gateway Service Executable |
- MD_1_P16.KID | MD*1.0*16 KIDS Build |
- MD_1_P16_IG.pdf | MD*1.0*16 Clinical Procedures (CP) V1.0 Flowsheets Module Installation Guide |
- MD_1_P16_IMP.pdf | MD*1.0*16 Clinical Procedures (CP) V1.0 Flowsheets Module Implementation Guide |
-MD_1_P16_RN.pdf  MD*1.0*16 Clinical Procedures (CP) V1.0 Flowsheets Module Release Notes

-MD_1_P16_TM.pdf  MD*1.0*16 Clinical Procedures (CP) Technical Manual and Package Security Guide

-MD_1_P16_UM.pdf  MD*1.0*16 Clinical Procedures (CP) V1.0 Flowsheets Module User Manual

-RoboEx32.dll .DLL file required to access Help files

**MD1_0P16_Flowsheets.zip** (includes the 4 files indented below)

-CPFlowsheets.exe MD*1.0*16 CP Flowsheets Executable

-CPFlowsheets.hlp MD*1.0*16 CP Flowsheets online Help file

-CPFlowsheets.cnt MD*1.0*16 CP Flowsheets online Help contents file

-RoboEx32.dll .DLL file required to access Help files
2.3. Flowsheet Design

The CP Console provides the tool to build the flowsheet views and layouts. In the pre-implementation phase, a copy of the current paper flowsheet should be reviewed. The design of the electronic flowsheets can then be established based on the review.

Sample Views are available for import. A copy of these views can be made once imported onto your system, and the copy can then be edited so that it is customized for your facility. You can also create a view from scratch.

CP Flowsheets are built from the CP Views. You can apply the same view to many flowsheets. It is important to remember this because if an edit is done on a CP View, that edit will be reflected on all the CP flowsheets that have that CP view assigned.

2.4. Flowsheet Coordinators

The facility will need to determine who will have access to build the views and flowsheets. IRM will need to assign permissions as requested. Additional information about permissions is available in Chapter 3: CP Console Overview.

The Flowsheet Coordinator should be given the MD ADMINISTRATOR key, which will give them permissions to all needed functions.

The Flowsheet Coordinator has the following key responsibilities:

- Manages and facilitates installation, implementation, maintenance, enhancements and overall use of CP Flowsheets throughout the medical center through ongoing needs assessments and evaluation processes.
- Serves as site coordinator for implementation and development teams at the facility level, including communication of issues with the executive stakeholders and program team to achieve resolution.
- Serves as a liaison to the VISN and national level teams for the CP Flowsheet application, to include facility representation at conference calls and/or educational programs.
- Coordinates and ensures initial and ongoing training for all CP Flowsheet users, including students, and temporary staff.
- Coordinates and ensures initial and ongoing usability assessments for the CP Flowsheet application and hardware systems.
- Facilitates initial and ongoing contingency system management.

2.5. Contingency Plans

Contingency procedures should be developed for scheduled and unscheduled downtime and coordinated with stakeholders prior to the implementation of the software. All applicable staff will need to be trained on the contingency plans.
3. CP Console Overview

CP Console is a replacement for CP Manager.

The CP Console window contains the following elements:

- Menu Bar
- Button Bar
- Detail Area
- Tree View

Note: MD*1.0*16 disables the use of CP Manager. Use CP Console to perform the functions previously provided by CP Manager.
3.1. CP Console Menu Bar

The CP Console Menu bar appears along the top of the window, under the Windows title bar. It contains three menu options: File, Tools, and Help.

3.1.1. File Menu

Use the File menu to add new items, rename existing items, delete items, save items, and exit CP Console.
3.1.1.1. New Menu

The New menu option allows you to create new flowsheets, flowsheet views, flowsheet totals, schedules, and shifts, as well as add instruments and procedures.

Figure 3-4, New Menu
3.1.1.2. Renaming an Item in the Tree View

Use **Rename** to change the name of an item in the tree view. To rename a flowsheet, a flowsheet total, a flowsheet view, an instrument, a procedure, or a shift, complete the following steps:

1. In the CP Console tree view, select an item. The worksheet for that item appears.
2. Click **File** and select **Rename**. The Rename <item> pop-up appears.

![Figure 3-5, Rename Flowsheet](image)

3. Type a new name.
4. Click **OK**. The new name appears in the tree view.

3.1.1.3. Deleting an Item

Use the **Delete** option to remove an item from the tree view. To delete a flowsheet, a flowsheet total, configuration parameters, or a shift, complete the following steps:

You can also delete items from the CP Console button bar.

![Figure 3-6, CP Console Button Bar](image)

**Note:** Since a Flowsheet is simply a data entity form, deleting a Flowsheet does not give you the ability to delete patient data. If you remove a term, view, or flowsheet, data still exists but is no longer viewable within Flowsheets.

1. In the CP Console tree view, select an item. The worksheet for that item appears.
2. Click **File** and select **Delete**. The Confirm pop-up appears.

![Figure 3-7, Confirm Delete](image)

3. Click **Yes**. The item is removed from the tree view.
Note: From the File menu, you can select Save to retain your additions and changes.

4. Select Exit to close CP Console.

3.1.2. Tools Menu

Use the Tools menu to locate items, assign permissions, refresh user roles, and export and import flowsheet views.

Note: If you make a change in CP Console, you will not see the change until you reload the Flowsheet.

4. Select Exit to close CP Console.

3.1.2.1. Search

On the Tools menu, click Search to look for an item in CP Console, such as a view, instrument, or procedure. Use the Console Find It Utility to perform your search.

Figure 3-8, Tools Menu

Figure 3-9, Console Find It Utility
3.1.2.2. Working with User Permissions

Use the Permissions option to add, remove, and modify users to items in the Tree view (i.e. View, Flowsheet, etc.) of Flowsheets and assign permissions (access) to those items. Any user with the MD ADMINISTRATOR key can assign permissions to any of the items in CP Console. Other users can assign permissions only to the items that they own/control. Security keys assigned to each user determine the overall access they have to CP Console (Refer to the Refresh Roles section for more details). Assigning permissions is a way of giving access to a user who would otherwise not have access to a specific item in the Tree view.

**Note:** You need MD ADMINISTRATOR to assign any permission to any object or you need to have full access granted to you for items you are assigning to another person.

Highlight the item in the Tree view that you want to give another user permission to configure.

On the Tools menu, click Permissions or click the Permissions button. The Access Control List Manager appears and displays the users and permissions for the highlighted item.

![Access Control List Manager](image)

**Figure 3-10, Access Control List Manager**

Use the Access Control List Manager to add users and their permissions, to change permissions, and to remove users. The Access Control List Manager offers a choice of four permissions that you can assign to a user:

- **Read-Only** - can only read items (default)
- **Read-Write** - can read, edit, and save items
- **Read-Write-Delete** - can read, edit, and save items, as well as delete some items
- **Full Control** - can do everything, which includes adding and removing users
3.1.2.3. CP Console Folder View Permissions

In CP Console, you need permission via Vista’s XPAR EDIT PARAMETER utility to see various folders in the CP Console tree view. With the proper permissions, you can have access to folders within the CP Console tree view including (VIEW, FS, SHIFT, and TOTALS).

Administrative functionality given by CP Console is no longer controlled primarily by role and security key. The visibility of folders is now controlled by entries in the Kernel Parameters package on a per-user basis. To make a folder visible to a specified user, the name of the folder must be entered EXACTLY as a parameter in XPAR EDIT PARAMETER:

Note: Security keys will still override settings in XPAR. If a user has MD ADMINISTRATOR, all folders in CP Console will be visible regardless of the folder permissions set in XPAR.

Figure 3-11, CP Console Folder View Permissions

Note: The MD Admin permission level will continue to have full access to all folders. To add/remove access folders using the XPAR, you will need to contact IRM Support.
3.1.2.4. Refresh Roles

Refresh Roles retrieves the current role (security key) assignments in VistA for the current user and displays them.

To refresh roles, complete the following steps:

1. From the Tools menu, select Refresh Roles and the Information pop-up appears with the roles assigned to the item selected.

![Information](image.png)

Figure 3-12, User Roles Assigned to Selected Item

- **MD ADMINISTRATOR** – CP Console requires the VistA MD ADMINISTRATOR role to create items in CP Console. The MD ADMINISTRATOR role includes MD MANAGER abilities with additional capabilities. CP Flowsheets requires the VistA MD ADMINISTRATOR role or the MD HL7 MANAGER role to access the HL7 Monitor. This role allows the holder full control of CP Flowsheets. Assign this role to users responsible for setting up and maintaining CP Console and CP Flowsheets.

- **MD MANAGER** – This role allows the holder to edit, audit, or rescind someone else’s data. Assign this role to power users of the CP Flowsheets patch to give them enhanced capabilities over a basic Flowsheets user.

- **MD HL7 MANAGER** - CP Flowsheets requires the VistA MD HL7 MANAGER role or the MD ADMINISTRATOR role to access the HL7 Monitor. Assign this role to a user who will assist with the HL7 messaging component of CP Flowsheets.

- **MD READ-ONLY** – Assign this role to a user to prevent them from entering data in Flowsheets. **DO NOT** assign MD READ-ONLY to a user concurrently with any role other than MD HL7 MANAGER. Doing so will lead to unpredictable results. A user with the MD READ-ONLY key may NOT log on to CP Console and will have limited functionality in CP Flowsheets.

- **MD TRAINEE** - This role has the same capabilities as a basic user except that all observations are unverified; a user who is not a trainee must verify all trainee observations. Assign this role to trainees.
3.1.2.5. Export to XML

Export to XML allows you to save your Instruments, Procedures, or Views to a disk as a backup of your flowsheet layouts. This allows administrators to share views or Flowsheets with other users or sites. To export to XML, complete the following steps:

Note: You must be assigned the role of MD ADMINISTRATOR to use this function.

1. On the CP Console Tools menu, click Export to XML. The CP Console Export Wizard appears.

![Figure 3-13, CP Console Export Wizard](image)

Figure 3-13, CP Console Export Wizard
2. Click **Next**. The CP Console Export Wizard asks you to select the type of items to export.

![Figure 3-14, CP Console Export Wizard Select Type](image)

3. Select **Instruments, Procedures**, or **Views** and click **Next**. The CP Console Export Wizard asks you to select the instruments, procedures, or views to export.

   **Note:** Import/Export of Views, Procedures, and Instruments are based on folder permissions that are controlled by XPar. You will only have access to Import/Export folders that you have permission to. For example, if you only have access to Views and Procedures you will not be able to import/export Instruments.

![Figure 3-15, CP Console Export Wizard](image)
4. Select the instruments, procedures, or views you want to export (in this example, instruments are being exported). You may select as many as you wish. You may press Ctrl-A to select all of the instruments, procedures, or views. Click Next. The CP Console Export Wizard asks you to enter or select the name of the file to export the selected instruments, procedures, or views.

![Figure 3-16, Export Filename and Comments](image)

Figure 3-16, Export Filename and Comments

5. Export Filename and Comments.
   a. Enter the name of the export file. To change the location where the file will be saved, click Browse and select the location.
      Or:
      To replace an existing file with the new export file, or click Browse and select the file to replace. Click Yes when prompted to replace the file.
   b. Optionally, you may add comments in the Comments box. Comments submitted in the Export Wizard will appear in the Import Wizard before you finish importing your views. These will be included in the XML export file.
   c. Click Next. The CP Console Export Wizard displays a preview of the XML file.
6. You can scroll to review the XML file. To export the file, click **Next**.

7. When the export is complete, click **Finish**.

### 3.1.2.6. Import from XML

You can import Sample views such as a method to share between sites.
3.1.3. Help Menu

The Help menu provides information about the application and access to online Help.

From the Help menu, select **About** to display information specific to the CP Console application.

Select **Contents** to display online Help for CP Console.

3.2. CP Console Tree View

In the left-hand panel, the CP Console tree view provides access to the following items: Background Task, Flowsheet, Flowsheet Total, Flowsheet View, Instrument, Parameters, Procedure, Schedule, and Shift.
3.3. CP Console Detail Area

When you select an item in the CP Console tree view, details for that item appear in the large panel to the right. This is the worksheet where you create, customize, and fine-tune your flowsheet views, flowsheet layouts, and so on.

Figure 3-21, Item Detail Area

The banner appears at the top of every detail area, indicating the name you assign to the item, the type of item you are creating or modifying (flowsheet, view, total), as well as the access level.
4. Working with Clinical Flowsheet Views

The following section details the basic tasks available within CP Console.

To get started, you will need the following:

- You must have the **MD ADMINISTRATOR** key
- Access to the **CP Console** executable
- Menu Option **MD CLIO** must be assigned

Within CP Console, you can complete the following tasks:

- Import Sample Views
- Customize Flowsheet Views
- Create a Flowsheet
- Add, Edit, or Remove a view from an existing flowsheet

**IMPORTANT**: If you are importing views from a different site, you need to copy and rename them. See Renaming a Copied View for more details.

See Also – Importing Views from XML, step 6. If you click yes to the CP Console Import Wizard Confirm Warning message, your imported view will be overwritten. Make sure that you make a copy of the existing view to retain its contents.
4.1. Importing Views from XML

Sample Views for Flowsheets are available for download. You can copy sample views as a starting point for creating custom views. They are available on the anonymous FTP site as MD1_0P16_Sample_Views.xml. Contact your local IRM Support to retrieve this file from the designated FTP server.

You can also follow these steps to import custom views.

1. On the CP Console Tools menu, click Import from XML. The CP Console Import Wizard appears.

![Figure 4-1, CP Console Import Wizard](image)

2. Click Next. The CP Console Import Wizard asks you to enter or select the name of the file to import.

![Figure 4-2, CP Console Import Wizard Import Filename](image)
3. Enter MD1_0P16_Sample_Views.xml, or click **Browse** and select the file to import. The CP Console Import Wizard displays the file header.

**Note:** Import/Export of Views, Procedures, and Instruments are based on folder permissions that are controlled by XPar. You will only have access to Import/Export folders that you have permission to. For example, if you only have access to Views and Procedures, you will not be able to import/export Instruments.

![Figure 4-3, CP Console Import Wizard File Header](image)

4. Click **Next**. The CP Console Import Wizard asks you to select the components to import.
5. Press Ctrl-A to select all of the components. Click **Next**.

6. If you import a view that has a Flowsheets view internal number that is the same as a view that already exists in CP Console, the imported item will overwrite the existing item. The CP Console Import Wizard displays a confirmation box to confirm that you want to overwrite the existing item.

   **Figure 4-5, CP Console Import Wizard Confirm**

   **WARNING!** If you click **Yes**, it will overwrite the existing item. To import a view and still retain the existing item, **before you import the new item**, make a copy of the existing item (refer to the **Making a Copy** section for more details), then import the new item. The import will still overwrite the original item, but it will not overwrite the copy.

   **Note:** **Sample Views** are read-only and cannot be changed.

   To confirm the import of the item, click **Yes**. To retain the existing item and cancel the import of the new item, click **No**.
If you are importing more than one item that has a Flowsheets internal ID that is the same as a view that already exists in Flowsheets, the CP Console Import Wizard will display a confirmation box for each item.

7. During the import, the CP Console Import Wizard displays a progress report of the components as they are imported.

![CP Console Import Wizard](image)

**Figure 4-6, CP Console Import Wizard Progress Report**

8. When the import is complete, click **Finish**.

![Close Application Confirmation](image)

**Figure 4-7, Close Application Confirmation**

9. To apply the changes, you must restart CP Console. To close CP Console, click **OK**.

After you complete the import and restart CP Console, the views you imported are now available under the **Flowsheet View** folder as shown below.

**Note:** The views you import will be in an “Inactive” status. These views will need to be “Active” before they are available for use.
The following figure shows what the imported sample views will look like:

![Figure 4-8, Imported Views](image)

### 4.2. Customizing Flowsheet Views

In order to customize the views for your site, complete the following tasks:

- Make a copy of a sample view
- Rename a copied View
- Edit renamed views

**Important:** When you are editing a Flowsheet view, you should reload a flowsheet if it has been edited in the console, or close the flowsheet if it is currently being edited. Otherwise, editing a view in CP Console can cause other open flowsheets that use that view to show an error.
4.2.1. Making a Copy

**Make Copy** allows you to copy a flowsheet view. The new view will have a Flowsheets internal ID that is different from the view that you copied. This is especially useful when you are customizing views that you have imported.

**Warning!**: The character limit in the rename field is 43 characters. An error appears if you copy a flowsheet view name longer than 43 characters. Rename the flowsheet view to a shorter name before you copy to avoid the error message.

**Note**: If you rename an imported view, it does not change the Flowsheets internal ID and the renamed view could still be overwritten. If you Make a Copy of a view, it is assigned a new Flowsheets internal ID and will not be overwritten later by an imported view.

1. In the CP Console tree view, select a view. The worksheet for that view appears.
2. On the **File** menu, click **Make Copy** or click the **Make Copy** button.

![Figure 4-9, Make Copy Button](image)

**Figure 4-9, Make Copy Button**

3. The Confirm Copy pop-up appears.

![Figure 4-10, Confirm Copy](image)

**Figure 4-10, Confirm Copy**

4. Click **Yes**. The copied view appears in the tree view.
5. The view you just created is listed in the tree view with the words “Copy of” preceding the name of the view you copied.

4.2.1.1. Renaming a Copied View

After you copy a view, rename the view you just created. To rename a copied view, complete the following steps:

1. From the buttons at top of the CP Console menu, click **Rename**.

![Figure 4-11, Copied View](image)

![Figure 4-12, Rename Button](image)
2. The **Rename Flowsheet** window appears.

3. In the **New Name** field, rename your flowsheet view.

![Rename Flowsheet View](image)

**Figure 4-13, Rename Flowsheet**

4. Click **OK**.

5. The renamed Flowsheet View will now appear in the Flowsheet View tree list.
4.2.1.2. Protecting an Imported or Exported View

The following flow diagram illustrates steps you can follow to protect an imported or exported view.

---

**Figure 4-14, Protecting an Imported or Exported View**
4.2.2. Creating a New Flowsheet View

If you choose not to copy a view, you can create your own view using the following steps.

You can create views specific to your site to assemble into your customized flowsheets. You can create an unlimited number of views. A flowsheet view is comprised of terms, parameters, and qualifiers. You can assemble one or more flowsheet views into a flowsheet that you use for entering patient data into CP Flowsheets. A customized flowsheet view allows you to add, edit, and remove terms, as well as change the display order of the terms.

To create a flowsheet view:

1. From the File menu, highlight New and select Flowsheet View. The Create New Flowsheet View pop-up appears.

2. In the Name box, type a name for the new view. The name appears in the tree view and as the Item Name at the top of the CP Console main window.

3. Click OK. The new Flowsheet View worksheet appears.
4. The name you just added appears in the Display Name box.
5. From the **Time Interval** list, select a time interval to display across the y-axis (columns).
6. From the **X-Axis** list, select a list, **Terminology** or **Date/Time**, to display across the x-axis (rows).
7. **Optional:** In the **Comment** box, type additional information about the view.
8. To make the view available in CP Flowsheets, select the **Active** check box.
9. To be able to switch axes, the intervals (columns) with the lists (rows), select the **Allow Pivot** check box.
10. Click **Save** to save your new Flowsheet View.

**Flowsheet View Definitions**

The following are definitions specific to **Flowsheet Views:**

**Display Name:** Display Name describes the flowsheet view with a unique name, so you can identify it in the list of flowsheet views.

**Time Interval:** Time Interval sets the default time interval for the view display when accessed through CP Flowsheets. Choices range from one minute to 24 hours.

**X-Axis:** X-Axis sets the column headers along the top of a view to Date/Time or Terminology selections. Y-axis represents data type (rows) along the left side of a view.

**Comment:** Optional – You can provide additional information regarding the flowsheet view.

**Active:** The flowsheet view is active and available in CP Flowsheets.

- Select the Active check box to make the flowsheet view active and available.
- Clear the Active check box to inactivate the flowsheet view.

**Note:** If the Active check box is not selected, the view does not load and you cannot enter data. A pop-up appears to indicate that the view is not active. The inactive view may display in the report.

In the tree view, an active view appears with 📊.

![Figure 4-17 - Active View](image)

**Allow Pivot:** Allow Pivot switches the x-axis (column) selection to present along the y-axis (row) of a view. You can make the switch while using the flowsheet. Select and clear the check box to change the default view of the flowsheet view.
4.2.3. View Terminology Editor

Display Name: You assign a name to the view that appears in CP Flowsheets on your flowsheet.

Use the View Terminology Editor window to add terms (click Add) and to modify existing terms (click Edit).

![View Terminology Editor](image)

Figure 4-18, View Terminology Editor
4.2.4. Adding Terms to a View

Use the View Terminology Editor window to add terms to a view. To add terms to a view:

1. Click on the view you would like to modify.

2. Click the Add button. The View Terminology Editor window appears.

3. From the Term drop-down list, select a term.

   **Note:** The Term list contains terms provided with CP Console. You cannot add terms to the CP Console list. If you need to request or modify a term, refer to the following site for Terminology information:


4. To set the default unit of measurement, if the selected term requires a default unit, select a unit from the Default Unit drop-down list.

   **For Example:**
   Body temperature is always entered in degrees Fahrenheit. Select Degrees F from the drop-down list. The end user does not need to select Degrees F every time they enter a temperature.

5. **Optional:** Change the display name.
   The Display Name automatically populates when you select a term.

6. To set a display width, select a width (in number of characters) from the Display Width drop-down list.
7. To set the display columns, if the selected term requires columns, select the number of columns to display from the **Display Columns** drop-down list.

8. Select the **Use Dropdown** check box to display the selections in a flowsheet in a drop-down list rather than as radio buttons.

9. From the **Term Display Properties** box, select one or more check boxes to provide calculations automatically in the view:
   - Display Totals Row
   - Display Average Row
   - Display Count Row
   - Display Min Value Row
   - Display Max Value Row
   - Display Subtotals by Time Interval
   - Display Row as Read Only
   - Input required for this term

Refer to the following section, **Term Definitions** for further detail on the above terms.

10. If the term you select has qualifiers associated with it, you need to make additional selections. Not all terms have qualifiers.
   a. Select one or more check boxes of the available qualifiers.
   b. Select descriptors for the qualifiers from the respective drop-down lists.
   c. Select the appropriate Mandatory check boxes to make qualifiers required fields.

   **For Example:**

   Weight has three qualifiers available: Method, Location, and/or Position. Define a method for taking the weight, by selecting a descriptor.

11. Click **OK**.

12. Click **Save**.

13. To add additional terms to a view, repeat steps 1-11.

### 4.2.4.1. Term Definitions

The Term section allows you to customize the term parameters and associated qualifiers.

**Term:** Term is the approved, standardized wording used for the observed clinical procedure/activity.

**Default Unit:** Default Unit is the unit of measure at which to set the default. You must select a default unit for a numeric unit.

**Example**

Body temperature is always entered in degrees Fahrenheit. Select Degrees F from the drop-down list. Then you do not need to select Degrees F every time you enter a temperature.
Display Name: Display Name describes the selected term with a unique name, so you can identify it in the list of terms.

Display Width: Display Width is the maximum number of characters used in the field.

Display Columns: Display Columns is the number of columns to display in the view.

Use Dropdown: Use Dropdown allows you to display selections in a flowsheet in a drop-down list rather than a radio button options.

Display Only: Display Only prevents you from manually adding data for the observations.

Term Display Properties: You can select one or more properties for the selected term to provide calculations automatically for display in the view.
- Display Totals Row—provides a totals row for observations for display in the view
- Display Average Row—provides an average row for the observations for display in the view
- Display Count Row—provides a count row for the observations (the number of results in a particular column) for display in the view
- Display Min Value Row—provides a minimum value row, a row of the lowest number of observations
- Display Max Value Row—provides a maximum value row, a row of the highest number of observations
- Display Subtotals by Time Interval—provides subtotals by time intervals (calculations automatically by time intervals) for the observations for display in the view
- Display Row as Read Only—allows a row to be labeled read only for display in the view
- Input required for this term—indicates whether the term must have observations recorded

4.2.5. Working with Qualifiers

A qualifier is an additional choice you can add to a term, such as the examples below. Not all terms have qualifiers. A term can have several qualifiers as specified in the terminology list. Those that display depend on the term you select. If the term you select has qualifiers associated with it, you can make additional selections.

Identify the type of qualifier by selecting the associated check box, such as:
- Method—lift scale, monitor
- Quality—actual, estimated
- Location—L arm, right upper lobe
- Position—sitting, standing
- Product—platelets, 5 percent albumin

Indicate that a qualifier is a required field by selecting a Mandatory check box.

If a qualifier is set to Mandatory, you cannot clear the qualifier from the flowsheet view data entry form.

Note: You can clear the qualifiers that are not mandatory with the ESC key.

Select a descriptor for the type of qualifier from the respective drop-down list.
- When you do not select a qualifier, no default appears in the qualifier drop-down.
- When you select a qualifier, it appears in the drop-down as an editable default.
• When you select a qualifier and select mandatory, the qualifier appears in the drop-down and you cannot change it.

For Example:

Systolic Pressure has three qualifiers available: Method, Quality, and/or Position. Define a method for reading systolic pressure by selecting one or more of the qualifiers with associated parameters.

For information on creating a flowsheet view, refer to the Creating a Flowsheet View section in Chapter 4.

4.2.6. Changing the Display Order of Terms in a View

Use Move Up and Move Down to change the display order of the terms in a view. To change the display order of terms in a view:

1. Highlight the term you want to move in the display order of the view.

2. Click to move the term up in the display order or click to move the term down in the display order.

3. Click Save.

4.2.7. Modifying Terms in a View

Use the View Terminology Editor window to modify the term qualifiers and associated descriptors of the terms of newly created views, as well as existing views. To edit terms in a view:

1. Highlight a term from the Terminology list.

---

**Figure 4-20, Terminology List**
2. Click ![Edit ...](image). The View Terminology Editor window appears.

![Figure 4-21, View Terminology Editor](image)

3. Change any or all of the parameters in the **Term** section.

4. If the term has qualifiers, change any or all of the qualifiers/descriptors in the **Qualifiers** section.

![Figure 4-22, Inactive Term](image)
Note: An asterisk next to the term indicates an inactive term. Also, when you select an inactive term, a pop-up appears stating that the term is marked inactive.

5. Click OK.
6. Click Save.
7. To edit additional terms in existing views, repeat steps 1-6.

4.2.8. Removing Terms from a View

Use Remove to delete terms from a newly created or existing view. To remove terms from a view:

1. From the Terminology list, highlight a term.

![Figure 4-23, Terminology List](image)

2. Click Remove. Confirm pop-up appears.

![Figure 4-24, Confirm Pop-up](image)

3. Click Yes.
4. Click Save.
5. To remove additional terms from a view, repeat steps 1-4.
This page intentionally left blank for double-sided printing.
5. Creating Flowsheets in CP Console

CP Console allows you to create flowsheet views and flowsheet totals, which you assemble into your individualized flowsheets to meet your site-specific requirements. Although the order in which you create the parts of a Flowsheet is not critical (you may use some sample flowsheet views and totals supplied with Flowsheets), you must have the following components to create a Flowsheet.

- Flowsheet view(s), including sample flowsheet views supplied with Flowsheets, that contain the information you want to include on your Flowsheet. Before publishing a Flowsheet, you must find or create the flowsheet views you wish to include on your Flowsheet.
- Flowsheet total(s) including sample flowsheet totals supplied with Flowsheets, which contain the information you want to include on your Flowsheet. Before publishing a Flowsheet, you must find or create the flowsheet totals you wish to include on your Flowsheet.

To create a Flowsheet in CP Console, complete the following steps:

1. From the File menu, highlight New and select Flowsheet. The Create New Flowsheet pop-up appears.

![Create New Flowsheet](image)

**Figure 5-1, Create New Flowsheet**

2. In the Name box, type a descriptive name for the new flowsheet, for example ICU_VITALS or NHCU_VITALS. The name appears in the tree view and as the Item Name at the top of the CP Console main window.

3. Click OK. The new Flowsheet worksheet appears.
5.1. Adding a new Flowsheet

To add a new flowsheet:

1. In the **Display Name** box, type a name for the new flowsheet.
2. To make the flowsheet available in CP Flowsheets, select the **Active** check box.
3. **Optional:** In the **Comment** box, type additional information about the flowsheet.

   **Note:** This comment is only visible in CP Console.

4. Make sure an appropriate TIU title exists and is active in CPRS.
5. From the **TIU Note Title for reporting** list, select a note title to display in CPRS.

   **Note:** Selection is most accurately done by copying the TIU note title from CPRS or Vista or paste the title onto a text page, for example, Notepad or MSWord. Copy and paste the title name into the General section - "TIU note title for reporting".

You have the option to QUICKLY type the first 3-4 characters of the TIU note title. However, if you have several note titles that start out with the same 3-4 characters such as NURS, this could cause your system to lock up. Therefore, it is recommended that you copy and paste note contents.

6. Click **Add**. The **New Flowsheet Page** window appears.
5.1.1. Adding a View to a Flowsheet

Use the New Flowsheet Page window to add a view to a new or existing flowsheet. To add a view to an existing flowsheet:

1. Select the Pages tab and click **Add …**. The New Flowsheet Page window appears.

![New Flowsheet Page](Image)

2. Select a view from the **View** drop-down list.

   **Note:** The View list contains the flowsheet views you created under Flowsheet View in CP Console, along with any default flowsheet views created by the development team.

3. The **Display Name** automatically populates when you select a view. If you change the display name, the view name changes in CP Console, and appears as Page Name in a new session of CP Flowsheets.

4. Select a type from the **Page Type** options: Mandatory, Optional, or Supplemental (defined below)
   - Mandatory – mandatory views cannot be closed
   - Optional – the optional view is not always displayed. Optional views can be added one at a time (for example, ventilator or pacemaker) and can be turned on or off as necessary and continue to be used with no loss of data.

   **Note:** An optional view is configured to document assessments related to singular non-invasive device types where documentation flow is suitable to follow on a continuum with the original entry.

The optional view is added for initial documentation for a number of hours/days. The view can be closed after the device is discontinued. If the device is later placed back into use, adding the optional view again re-activates the original view for continuing documentation.

If you are tracking usage of model numbers, lot numbers, or invasive lines, then configure device assessments in a supplemental view.

   - Supplemental – you can use the view, but it is not necessary for all flowsheets; a supplemental view does not display initially, you have to add it to the flowsheet. You can use
multiple supplemental views (for example IV bags or multiple wounds). If you close a supplemental view and add a new one, the new one will be blank. The data is locked into that view. The closed supplemental view can still be viewed on the flowsheet and report.

5. Click **OK**.
6. Click **Save**.
7. To add additional views to a flowsheet, repeat steps 1-6.
   
   **Note:** There are no restrictions to the number of times a view can be added to a flowsheet.

### 5.1.2. Pages Tab

Use the Pages tab to add, edit, or remove a view, as well as arrange the display order of the views on a flowsheet.

![Figure 5-4, Pages Tab](image-url)
5.1.3. Editing a View Type in a Flowsheet

Use the Edit Flowsheet Page window to change a view type in a new or existing flowsheet. To edit a view in a flowsheet:

1. Select the Pages tab, highlight a view.

![Figure 5-5, Pages Tab](image)

2. Click . The Edit Flowsheet Page window appears.
3. From the View drop-down list, select a view to modify.
4. Optional: Change the display name.
5. From the Page Type options, select a Page Type: Mandatory, Optional, or Supplemental.
6. Click OK.
7. Click Save.
8. To edit the page types of additional views, repeat steps 1-7.
5.1.4. Removing a View from a Flowsheet

You can use **Remove** to delete a view from a flowsheet. To remove a view from a flowsheet, complete the following steps:

1. Select the **Pages** tab. Highlight the view to delete.

![Figure 5-6, Highlight View to Delete](image)

2. Click **Remove**.
3. Click **Save**.

5.1.5. Changing the Display Order of Views in a Flowsheet

Use **Move Up** and **Move Down** to change the display order of the views in a flowsheet. To change the display order of views in a flowsheet, complete the following steps:

1. Highlight the view you want to move in the display order of a flowsheet.

![Figure 5-7, Highlight View to Move](image)
2. Click ✆ Move Up to move the view up in the display order or click ✅ Move Down to move the view down in the display order.

3. Click Save.

5.2. Creating a Flowsheet Total

The flowsheet total allows you to display the sum of numeric observations within that flowsheet view.

**Note:** Totals are based on active date ranges from the displayed flowsheet. The calculation of the totals can include observations that may not be on the displayed flowsheet.

The following screen illustrates the active date ranges from the displayed flowsheet:

![Active Date Ranges](image)

Figure 5-8, Active Date Ranges

Additional configuration approaches are addressed in supplemental documentation.
Creating flowsheet totals involves adding and removing terms, as well as changing the display order of the terms.

![Create a Flowsheet Total](image)

**Figure 5-9, Create a Flowsheet Total**

To create a flowsheet total:

1. From the File menu, highlight **New** and select **New Flowsheet Total**. The Create a New Flowsheet Total pop-up appears.

![Totals Display from CP Flowsheets](image)

**Figure 5-10, Totals Display from CP Flowsheets**
2. In the Name box, type a name for the new total. The name appears in the tree view and as the Item Name at the top of the CP Console main window.

3. Click OK. The new Flowsheet Total worksheet appears.

### 5.2.1. Editing the Flowsheet Total

1. In the Display Name box, type a name for the new total.

2. To set the default unit, select a unit from the Default Unit drop-down list.

3. From the Decimals box, select the number of decimals for the default unit, 0-8. Default is 2.

4. Optional: In the Comment box, type additional information about the flowsheet total.

5. To make the total available in CP Flowsheets, select the Active check box.

6. From the Display Properties box, select one or more check boxes to provide calculations automatically on the view:
   - Display Total (All Terms)
   - Display Count (All Terms)
   - Display Average (All Terms)
   - Display Minimum
   - Display Maximum

### 5.2.1.1. Terminology Section

1. To move a term from the Available Terms list, select the term and click to move it into the Selected Terms list.

2. To move a term from the Selected Terms list, select the term and click to move it into the Available Terms list.

3. Repeat steps 1 and 2 as many times as is necessary.

4. To arrange the list of Selected Terms in a specific display order, select a term and click to move the term up the display order or to move the term down the display order.

5. Repeat step 4 until you have the list in specific display order.
6. Click Save.

5.2.2. Totals Tab

From the Flowsheets tree, select the Totals tab to add totals to and remove totals from a flowsheet, as well as, change the display order of totals on a flowsheet.

![Figure 5-12, Totals Tab](image)

5.2.2.1. Adding Totals to a Flowsheet

To add a total to a flowsheet:

1. On the Totals tab, highlight the total in the Available Totals list you want to add.

2. Click \( \rightarrow \). The total moves to the Assigned Totals list.

3. Click Save.
5.2.2.2. Removing Totals from a Flowsheet

You can use the left arrow to remove a total from a flowsheet. To remove a total from a flowsheet:
1. On the Totals tab, highlight the total in the Assigned Totals list you want to remove.
2. Click left arrow. The total returns to the Available Totals list.
3. Click Save.

5.2.2.3. Changing the Display Order of Totals in a Flowsheet

Use the up arrow and the down arrow to change the display order of the totals in a flowsheet. To change the display order of the totals:
1. Highlight the total you want to move in the display order of a flowsheet.
2. Click to move the total up in the display order or click to move the total down in the display order.
3. Click Save.

5.3. Flowsheet Total

The flowsheet total allows you to display the sum of all observations of a single type within that flowsheet view. Totals use date ranges from the primary flowsheet form as ranges for the totals. The calculation of the totals uses all the intakes (observations) for a specified date/time range, which includes those that display on the flowsheet, as well as the intakes that do not.

1. From the File menu, highlight New and select Flowsheet Total. The Create New Flowsheet Total popup appears.

![Create New Flowsheet Total]

2. In the Name box, type a name for the new Flowsheet Total and click OK.
3. The new Flowsheet Total worksheet appears.

![Image of Flowsheet Total worksheet]

**Figure 5-14, Build a Flowsheet Total**

### 5.3.1. Understanding Totals Display

**Display Name:** Display Name describes the flowsheet total; it appears as the title of the report.

**Default Unit:** Unit of measure that the flowsheet total uses as a default.

**Decimals:** Number of decimal places for the unit, 0-8; default is 2.

**Comment:** Optional – You can provide additional information regarding the flowsheet total.

**Active:** The flowsheet total is active and available in CP Flowsheets.
- Select the Active check box to make the flowsheet total active and available.
- Clear the Active check box to inactivate the flowsheet total.

**Note:** If the Active check box is not selected, the flowsheet total does not load and you cannot enter data. A pop-up appears to indicate that the flowsheet total is not active. The inactive flowsheet total may display in the report. In the tree view, an active flowsheet total appears \( \sum \).

![Image of Flowsheet display properties]

**Figure 5-15, Active Flowsheet**

**Display Properties:** Select one or more properties to display on your flowsheet.
- **Display Total (All Terms)**—sum of all observation amounts
- **Display Count (All Terms)**—number of results of an observation within a flowsheet view
- **Display Average (All Terms)**—average of all observations
• **Display Minimum**—lowest number of observations
• **Display Maximum**—highest number of observations
• **Display Ratio (Term 1/Term 2)**
• **Display Difference (Term 1–Term 2)**

### 5.4. Setting up Default Shifts

Flowsheets allows you to set up standard default shifts for your site and departments. Additional configuration approaches are documented in supplemental documentation.

#### 5.4.1.1. Shift Information Definitions

The following are definitions for Shift Information in CP Console:

**Display Name:** Display Name describes the shift with a unique name, so you can identify it in the list of shifts.

**Active:** The shift is active and available in CP Flowsheets.
  - Select the Active check box to make the shift active and available.
  - Clear the Active check box to inactivate the shift.

**Note:** If the Active check box is not selected, you cannot use the shift in your flowsheets.

In the tree view, an active shift appears.

![Figure 5-16, Active Shift](image)

**Comment:** Optional - You can provide additional information regarding the shift.

**Start Time:** 12:00 AM through 11:45 PM in 15-minute increments.

**Stop Time:** 12:00 AM through 11:45 PM in 15-minute increments.

#### 5.4.1.2. Adding a Shift

Use the Shift Information worksheet to create your shifts. To add a shift:

1. From the File menu, highlight **New** and select **Shift**. The Create New Shift pop-up appears.

![Figure 5-17, Create New Shift](image)
2. In the **Name** box, type a name for the new shift. The name appears in the tree view and as the Item Name at the top of the CP Console main window.

3. Click **OK**. The new **Shift** worksheet appears.

![Shift Worksheet](image)

**Figure 5-18, Shift Worksheet**

4. In the **Display Name** box, type a name for the new shift.

5. To make the shift available in CP Flowsheets, select the **Active** check box.

6. **Optional:** In the **Comment** box, type additional information about the shift.

7. From the **Start Time** drop-down list, select a begin time.

8. From the **Stop Time** drop-down list, select an end time.

9. Click **Save**.

**5.4.1.3. Modifying an Existing Shift**

Use start and stop times to modify your shifts. To modify an existing shift:

1. From the CP Console tree view, highlight **Shift** and expand the folder.

2. Select a shift from the list. In the following figure, the “Days-2” shift is selected.
3. Make the necessary changes to one or more fields of the shift worksheet.
4. Click Save.
6. Additional Flowsheet Tasks

6.1. Setting up Background Tasks

CP Console background tasks are system activities (which run in the background) that you can schedule. The three available cleanups address CliO, CP Legacy, and the HL7 Cleanup. These settings are determined according to site policy.

![Figure 6-1, Background Tasks](image)

Select one of the background tasks and its properties appear.

![Figure 6-2, CliO Cleanup Background Task Properties](image)

- **Task ID**: The identifier assigned to the task.
- **Name**: The name of the background task.
- **Status**: The status of a background task can be Active: Pending or Active: Running.
- **Scheduled**: Scheduled indicates the date and time the background task begins; the Default is **Not Scheduled**.
6.1.1. CliO Cleanup

CliO is a database that stores patient observations. You can store data in a variety of formats. Old observations that are not in a state of verified or corrected are purged.

Note: If student/trainee documentation is not in a state of verified or corrected, it will also be purged.

To change the scheduling of CliO Cleanup:
1. Under Background Task, click CliO Cleanup.
2. Click Change.
3. Schedule the task. Refer to the Changing the Schedule for a Task section for more details.

6.1.2. CP Cleanup

CP Cleanup background task cleans up observations (unencoded or XML data) from instruments (monitors) that are not in a verified state (data that is not clinically relevant). This cleanup is designed to run after data is processed, and deletes the data that is not clinically relevant from both Legacy and CliO. It runs through the UPLOAD ITEM field in the CP RESULT REPORT file (#703.1) and purges unnecessary data from previous uploads.

To change the scheduling of CP Cleanup:
1. Under Background Task, select CP Cleanup.
2. Click Change.
3. Schedule the task. Refer to Changing the Schedule for a Task for more details.

6.1.3. HL7 Cleanup

The HL7 Cleanup purges messages not validated that remain more than a number of days set by you, in the HL7 log file.

To change the scheduling of HL7 Cleanup:
1. Click HL7 Cleanup.
2. Click Change.

Schedule the task. Refer to the Changing the Schedule for a Task section for more details.
### 6.2. Adding an Instrument

Use the new instrument worksheet to add new instruments to Clinical Flowsheets. To add an instrument, complete the following steps:

**Note:** The instrument worksheet is for *legacy CP instrument connections only*. For MD*1.0*16 connections, all information required will be exported as part of a centrally maintained mapping file.

1. From the File menu, highlight **New** and select **Instrument**. The Create New Instrument pop-up appears.

![Create New Instrument](image)

**Figure 6-3, Create New Instrument**

2. In the **Name** box, type a name for the new instrument. The name appears in the tree view and as the Item Name at the top of the CP Console main window.

3. Click **OK**. The new **Instrument** worksheet appears.

![New Instrument Worksheet](image)

**Figure 6-4, New Instrument Worksheet**

4. **Optional** – In the **Comment** box, type additional information pertaining to the instrument.

5. In the **Print Name** box, type the name as you want it to appear on the instrument report.
6. To make the instrument available in CP Flowsheets, select the **Active** check box.

7. In the **Serial Number** box, type the serial number of the instrument.

8. From the **Notification Mailgroup** drop-down list, select a local VistA mailgroup.
   
   Click in the box and type an alpha character, such as `b`, `p`, or `r`, at which you want the list of mailgroups to begin.

### 6.2.1. Modifying an Existing Instrument

Use the Instrument worksheet to modify the parameters of an existing instrument. To modify an existing instrument, complete the following steps:

1. In the tree view, highlight **Instrument** and expand the folder.

2. Select an instrument from the list.

In the following example, the **AWARE** instrument is selected.

![Figure 6-5, Selected Instrument](image)

3. Make the necessary changes to the fields of the instrument worksheet.

4. Click **Save**.
6.2.1.1. Using Make Copy for Instruments

Use the Make Copy button to make a copy of an existing instrument for use in creating additional instruments.

**Warning!**: The character limit in the rename field is 23 characters. An error appears if you copy an instrument name longer than 23 characters. Rename the instrument to a shorter name before you copy to avoid the error message.

1. In the tree view, highlight and expand the **Instrument** folder.
2. Select an existing instrument you want to copy.
3. Click the Make Copy button on the top of the screen.
4. The Confirm Copy dialog box is displayed.
5. Click Yes. The copied instrument appears in the tree view.
6.2.1.2. Renaming a Copied Instrument

After you copy an instrument, rename the instrument you just created. To rename a copied instrument, complete the following steps.

1. From the buttons at top of the CP Console menu, click **Rename**.

![Figure 6-8, Rename Button](Image)

2. The **Rename Instrument** window appears.

![Figure 6-9, Rename Instrument](Image)

3. In the **New Name** field, rename the instrument

4. Click OK.

5. The renamed instrument appears in the tree view list.

6.2.2. Instrument Definitions

The following are definitions specific to Instruments:

**Comment:** Optional – You can provide additional information regarding the instrument.

**Print Name:** Name of the instrument to print on the instrument report.

**Active:** The instrument is active and available in CP Flowsheets.

- Select the Active check box to make the instrument active and available to transmit results.
- Clear the Active check box to prevent the instrument from transmitting results.

**Note:** If the Active check box is **not** selected, you cannot use the instrument in your flowsheets.

In the tree view, an active instrument appears.

![Figure 6-10, Active Instrument](Image)

**Serial Number:** Serial number of the instrument is assigned by the manufacturer.
Notification Mailgroup: Identify a local VistA mailgroup to notify when a problem arises with an active instrument.

### 6.2.3. Attachment Processing

Complete the following steps to select and process an attachment:

1. In the Default Ext box, type the default file extension exported by the vendor.
2. In the M Routine box, type the routine the instrument uses to process HL7 messages.
3. From the Pkg Code drop-down list, select the code of the processing package.
4. Select the Delete when submitted check box if the site does not store a duplicate report or the vendor deletes reports because of storage issues.
5. From the Valid Attachment Types options, select one or more method of attaching patient data.

The following are Attachment Processing definitions:

**Default Ext:** Default file extension exported by the vendor (.html, .pdf, .jpg).

**M Routine:** MUMPS routine used to process the HL7 message from the active instrument.

**Pkg Code:** Code of the package that processes the active instrument results.
- **Medicine** – Medicine package
- **CP V1.0** – Clinical Procedures v1.0
- **CliO** – Clinical Observation database

**Delete when submitted:** Select the check box if the site does not want to store a duplicate report outside of Imaging or the vendor wants to delete files because of storage issues.

**Valid Attachment Types:** The type of patient data expected from the instrument. Data type indicates to CP Console the kind of data output to expect from the instrument.
- **UUEncode** (Unix to Unix Encode)–a set of algorithms for converting files into a set of ASCII characters to transmit over a network
- **XML** (Extensible Markup Language)–a specification for Web documents developed by the World Wide Web Consortium (W3C), the organization that sets standards for the Web; XML is a pared-down version of Standard Generalized Markup Language (SGML)
- **XMS**–XML Style Sheet
- **DLL** (Dynamic Link Library)–a library of executable functions or data used by Windows applications
- **UNC** (Universal/Uniform Naming Convention)–a personal computer (PC) format for specifying the location of resources on a local-area network (LAN)
- **Text**–Text stored as ASCII codes
- **URL** (Uniform Resource Locator)–the global address of documents and other resources on the World Wide Web (www)

### 6.2.4. Adding a Configuration for a Bi-Directional Instrument

To add a configuration for a bi-directional instrument, complete the following steps:

1. If the instrument is bi-directional, select the **Bi-Directional Instrument** check box.
a. Type in the **IP Address** assigned to the instrument, the **Port** (location) assigned to the instrument, the **HL7 Instrument ID** for the instrument, and the **HL7 UNV SRV ID** for the instrument procedure.

b. From the **HL7 Link** drop-down list, select the unique link for the instrument. Click in the box and type an alpha character, such as \(b\), \(p\), or \(r\), where you want the list of instrument links to begin.

**Note:** This area of the screen is for informational purposes only.

2. Click **Save**.

The following are term definitions for bi-directional instruments:

**Bi-Directional Instrument:** An instrument that both sends and receives data.

**IP Address:** Each instrument at your facility must have an IP address. An IP address is a string of four integer numbers between 0 and 255 separated by periods.

**Port:** The location of the instrument to which you send data and from which you receive data.

**HL7 Inst ID:** The instrument ID in HL7 messages that identifies the instrument. The ID is provided by the vendor.

**HL7 Unv Svc ID:** The universal service ID for HL7 messages identifies the type of procedure the instrument performs when the instrument is capable of performing more than one procedure.

**HL7 Link:** There is one unique HL7 link for each instrument.

**6.2.4.1. Configuring a Bi-Directional Instrument to Receive Data Only**

You can set up a special bi-directional instrument configuration so that CP will send only an “outbound” HL7 message containing CPRS patient information to the instrument. The CP procedure is automatically placed in Complete status after the HL7 message is sent, thus preventing an “inbound” HL7 message containing the test results from being sent back to the CPRS Consult Note.

The physician can then edit the Consult Note by manually pasting in data from a test result reporting system to complete the Consult.

This configuration is beneficial for users of reporting systems—such as the Clinical Assessment, Reporting, and Tracking System for Cardiac Catheterization Laboratories (CART-CL) application—who do not want the test results from the medical instrument to populate the CPRS Consult Note but prefer to manually paste the test results from a different reporting system into the Consult Note.

To implement this configuration, your System Administrator must set a special flag in the CP Instrument File that will trigger the Complete status after the outbound HL7 is sent.

To configure a bi-directional instrument to receive data only, complete the following steps:

1. Set up a bi-directional instrument configuration as directed in Section 6.2.4.

2. Submit a request to your System Administrator to set the CONSULT KEEP OPEN field to **Yes** for the affected instrument in the CP Instrument File (#702.09). Be sure to include the instrument name in your request.
6.3. Working with Parameters

Parameters are set with CP Console.

You can configure the following items:

- CP ADT Feed
- CP Gateway Configuration,
- CP Parameters

![Figure 6-11, CP Console Parameters](image)

6.3.1. CP Parameters

Clinical Procedures system parameters affect all the procedures and instruments. You need to set the common parameters.

![Figure 6-12, Clinical Procedures Common Parameter Set](image)
6.3.2. Administering Notification Lists

A notification list editor is a tool that is part of the Clinical Procedures Common Parameter Set.

If you experience HL7 errors, the Notification List editor allows you to send a message to the specified member.

To administer notification lists:

1. Click the **Notification Lists** button.

![Notification List Editor](image)

**Figure 6-13, Notification List Editor**

2. In the Name list, select the list to edit. The members of the list appear in the Members box.

3. Use the **Add**, **Edit**, **Remove** buttons to edit the list.

4. Use the **Save List** button to save the list.

5. Use the **Test** button to send a test message to the members of the list.

The following are some additional terms specific to the Clinical Procedures Common Parameter Set:

**Clinical Procedures Home Page:** The Clinical Procedures Home page appears and directs the browser to this page when accessed. The data in this field is predefined.

**Imaging Network Transfer Directory:** This is the path to the Imaging network directory used for transferring data.

Use ![Browse](image) to browse to the appropriate location in the directory.

**Observation Retrieval Batch Size (Records):** The number of database (DB) records to pull at one time. Use the arrows to select a number of DB records to include in the batch.
Unverified Observation Retention (Days): The number of days to keep the unverified observations before purging. Use the arrows to select the number of days to retain unverified data. This is a CLIIO Cleanup task.

Instrument Data Retention (Days): The number of days to keep data from an instrument before purging. Use the arrows to select the number of days to retain instrument data. This is a CP Cleanup task.

- Select the check box to indicate Clinical Procedures is offline.
- Clear the check box to indicate Clinical Procedures is online.

Offline Message: When the Clinical Procedure System On Line check box is not selected, type a note in the Offline Message box to display when Clinical Procedures is offline.

Allow External Attachments: This affects Legacy CP. This allows you to find external attachments.
- Select the Allow External Attachments? check box to allow external attachments.
- Clear the Allow External Attachments? check box to not allow external attachments.

Bypass CRC Check: Bypass the Cyclical Redundancy Check during startup. On the server you can check the checksum of the running application to verify that it is the same as the checksum of the application distributed; the checksum value is associated with the version number of the software.
- Select the Bypass CRC Check? check box to perform the verification.
- Clear the Bypass CRC Check? check box to not perform the verification.

Note: If the checksum values do not match, a message appears indicating the values do not match.

Cache Terminology Files: This is the path to the network directory used for caching terminology files. Use \(\ldots\) to browse to the appropriate location.

Notification Lists: Administer the lists used for notification.

6.4. CP ADT Feed Configuration

The ADT (Admission/Discharge/Transfer) system allows VistA to notify third party devices (outgoing data to devices) that a patient was admitted, discharged, or transferred. ADT feed acts as an event handling system. You must configure the dynamic routing system, so that HL7 knows to which system to deliver the ADT messages. Link an ADT target to a protocol. For more information on configuring the CP ADT Feed, refer to the CP Flowsheets Module V1.0 Installation Guide.

Note: The subscriber protocol (MD DGPM PATIENT MOVEMENT) is provided and you must add it to the ITEM multiple of the DGPM MOVEMENT EVENTS entry in the protocol file. This allows the ADT feed to receive notification of patient movement.
6.4.1. Current ADT Targets

To remove an ADT target, highlight a line and click Delete Selected.

The following are definitions specific to ADT Targets:

Name: Name of the site
Protocol: Name of the subscriber protocol
Division: Division location of patient
Ward: Ward location of patient
Message Type: ADT
Event Type: ADT outbound (from VistA) message types
- A01 Admit/visit notification
- A02 Patient transfer
- A03 Discharge/end visit
- A08 Update patient information
- A11 Cancel admission
- A12 Cancel transfer
- A13 Cancel discharge/end visit

6.4.2. Adding an ADT Target

Use the Add ADT Target window to link an ADT target to a protocol. To add an ADT target:

1. Highlight Parameters in the tree view.
2. Select CP ADT Feed Configuration. The Current ADT Targets window appears.
3. On the Current ADT Targets window, click **New**. The Add ADT Target window appears.

![Add ADT Target](image)

**Figure 6-15, Add ADT Target**

4. From the **Protocol** list, select a protocol by name.

5. From the **Division** tree view, select an entire division or a ward within a division. (This allows Clinical Flowsheets to filter outbound messages by patient location.)

   **Note:** Selecting an entire division will not enable all outbound ADT messaging for the entire division.

6. In the **Protocol Link Name** box, type the protocol link name.

7. In the **HL7 Message Type** drop-down, **ADT** is the default.

8. From the **HL7 Event Type** drop-down list, select an ADT outbound message type.

9. Click **OK**.

   **Example**
   Protocol: MDSPL001
   Division: CHEYENNE VAMROC>C MEDICINE
   The MDSPL001 protocol receives the ADT A01 message only if the patient is moved, transferred, or discharged from the C MEDICINE location.

10. Repeat steps 4-9 for each HL7 event type you need to link.

### 6.5. CP Gateway Service Configuration

You must install the CP Gateway Service and configure the VistA server settings and the Gateway server settings for messaging to take place between VistA notification and ICU devices.

The CP Gateway Service exists as two subsystems, one solely within VistA, and the other as a Windows service that interacts with VistA by way of the RPC Broker. For more information on configuring the CP Gateway Service, refer to the **CP Flowsheets Module V1.0 Installation Guide**.

Use Gateway Server Settings to configure the gateway to restart automatically when the computer goes down.
6.5.1. VistA Server Settings

These settings allow the Gateway Service to restart automatically:

**Access Code:** Access code for the VistA service account with RPC Broker Context for CP Gateway (for more details, refer to the *CP Flowsheets Module V1.0 Installation Guide*).

**Verify Code:** Verify code for the VistA service account with RPC Broker Context for CP Gateway (for more details, refer to the *CP Flowsheets Module V1.0 Installation Guide*).

VistA server address settings are stored on the workstation in the system registry. They allow the CP Gateway Service to connect to the appropriate VistA system at startup.

**RPC Broker Port:** Port on which the CP Gateway Service connects to the broker.

**IP Address:** IP address at which the CP Gateway Service connects to the VistA system.

6.5.2. Gateway Server Settings

The following are definitions specific to the Gateway Server:

**IP Address:** Each server must have an IP address. An IP address is a string of numbers with format: `xx.xx.xx.xxx`. IP address of the workstation on which the CP Gateway Service is installed.

**Notify Port:** The listening port of the local machine. The port must be open when sending a message to the workstation. The default is 8888.

**Log Level:** The level of detail to log in the Windows Event Viewer for the CP Gateway Service.
- **Critical** – severe errors only
- **Error** – critical + errors that cause instability in the operation of the Gateway Service
- **Warning** – critical + error + any items captured but allowed the Gateway Service to continue running
• **Detail** – critical + error + warning + detailed execution trail of everything that the Gateway Service does as it processes HL7 messages

**Log Directory:** The log file tracks all the background operations and any problems that occur during processing. This is the directory in which the CP Gateway Service stores the logs.
Type in the location of the log directory.
The default directory for the log file is C:\

**Days to Retain Data:** The number of days to allow processed messages to remain in the log prior to purging. After the number of days indicated, the data is purged during HL7 Log Cleanup.
  • Use the arrows to set the number of days to retain messages.
  • Leave the field empty or at 0 to retain the data indefinitely.

**CP/Imaging Xfer Directory:** This is the directory in which Imaging stores CP transfer data.

**Data Retrieval Mechanism:** The method to use for data retrieval–your data source: **VistA Notification** or **Polling**.
Set the interval to **VistA Notification**. In **VistA Notification**, the VistA server will automatically notify the CP Gateway whenever a message arrives that requires processing. This is the preferred setting. Sometimes, however, local business requirements dictate that the **Polling** option be used. This option acts like the legacy CP Gateway, in that the CP Gateway will be polled periodically for data to process.

**Polling Interval:** The CP Gateway Service polls for new instrument data to transmit to VistA.
When you select **Polling** as the data retrieval mechanism, use the arrows to set the number of seconds between polling operations. A new value becomes effective after the next polling operation.

### 6.6. Working with Procedure Information

Legacy procedure information is populated through the CP DEFINITION file (#702.01), but you need to populate additional fields to complete the process. You can add new procedures and modify existing procedures. In order to use a procedure in a flowsheet, you must select the **Active** check box to activate it. Also, you need a primary key (MD ADMINISTRATOR or MD MANAGER) to edit and add procedures.
6.6.1. Adding a Procedure

Use the new procedure worksheet to add new procedures to CP Flowsheets. To add a procedure:

1. From the File menu, highlight **New** and select **Procedure**. The Create New Procedure pop-up appears.

2. In the **Name** box, type a name for the new procedure.

3. Click **OK**. The new **Procedure** worksheet appears.
The name appears in the tree view and as the Item Name at the top of the CP Console main window.

Figure 6-19, Procedure Worksheet

6.6.2. Modifying an Existing Procedure

Use the Procedure worksheet to modify the parameters of an existing procedure. In the following example, the AIRWAY RESISTENCE procedure is selected.

To modify an existing procedure:

1. In the tree view, highlight and expand the Procedure folder.
2. Select a procedure from the list.
3. Make the necessary changes to one or more of the fields of the procedure worksheet.
4. Click Save.
6.6.2.1. Using Make Copy for Procedures

Use the Make Copy button to make a copy of an existing procedure for use in creating additional procedures.

**Warning!** The character limit in the rename field is 23 characters. An error appears if you copy a procedure name longer than 23 characters. Rename the procedure to a shorter name before you copy to avoid the error message.

1. In the tree view, highlight and expand the **Procedures** folder.
2. Select an existing procedure you want to copy.
3. Click the Make Copy button on the top of the screen.

![Figure 6-20, Make Copy Button]

4. The Confirm Copy dialog box is displayed.

![Figure 6-21, Confirm Copy]

5. Click Yes. The copied procedure appears in the tree view.
6.6.2.2. Renaming a Procedure

After you copy a procedure, rename the procedure you just created. To rename a copied procedure, complete the following steps:

1. From the buttons at top of the CP Console menu, click **Rename**.

   ![Rename Button](image)

   **Figure 6-22, Rename Button**

2. The **Rename Procedure** window appears.

   ![Rename Procedure](image)

   **Figure 6-23, Rename Procedure**

3. In the **New Name** field, rename the procedure.
4. Click OK.
5. The renamed procedure appears in the tree view list.
6.6.3. Procedure Definitions

The following are definitions specific to Procedure:

**Treating Specialty:** This is the specialty under which the procedure falls. The list comes from the TREATING SPECIALTY file (#45.7).

**Hospital Location:** The location in the hospital in which the procedure is performed. The list comes from the HOSPITAL LOCATION file (#44); workload credit for the procedure is tracked through hospital location.

**TIU Note Title:** The title of an appropriate note with which to reference the active procedure. The list comes from the TIU DOCUMENT file (#8925). This must be a Generic TIU Note title.

**Description:** This is information describing/identifying the procedure.

**External Attachment Directory:** This is the directory in which you find attachments. If you select the Require External Data check box, type in the path to the location of the data, or browse to locate a directory.

**Require External Data:** The procedure requires external attachments, such as an independent report from another facility.

**Auto Submit to VistA Imaging:** Automatically submit to VistA Imaging when the procedure is processed by a bi-directional instrument and additional data does not need to be matched. When the check box is not selected, the study is in the Ready to Complete status.

**High Volume Instrument:** A medical device that sends over 200 observations per day.

**Note:** The High Volume Instrument option is not active in this release of Flowsheets. It will be active in the next release.

**Active:** The procedure is active and available in CP Flowsheets.
• Select the Active check box to make the procedure active and available.
• Clear the Active check box to inactivate the procedure.

Note: If the Active check box is not selected, you cannot use the procedure in your flowsheets.

In the tree view, an active procedure appears.

![NEW PROCEDURE]
[Diese Bildschirmaufnahme wurde mit Bildschirmfoto und Eingabe erstellt, es wird keine Änderung in der Dokumentation vorgenommen.]

Figure 6-25, Active Procedure

Processing Application: Select one application that performs the processing.
• Default (CP)–Clinical Procedures
• Hemodialysis–Hemodialysis package

Processed Results: Processed results indicate whether a final result, multiple results, or a cumulative result is associated with a particular procedure. Select one type of result.
• Final Result–default
• Multiple Results–allows creation of a new TIU note for each result sent back
• Cumulative Result–allows a multiple-result device to continuously send results back to the same TIU note

6.6.4. Allowable Instruments

Allowable instruments are a list of instruments providing results for the procedure that appear in the Allowable Instruments group box. If you want to use an external attachment, do not select any instruments.

6.6.5. Working with the Procedure Worksheet

To make a procedure available in CP Flowsheets, complete the following steps:
1. Click inside the Treating Specialty drop-down list, and type an alpha character, such as c, t, or n, at which you want the list of specialties to begin.
2. From the Hospital Location drop-down list, select a hospital location. Click in the box and type an alpha character, such as c, t, or n, at which you want the list of locations to begin.
3. From the TIU Note Title drop-down list, select a note title to display in CPRS. Click in the box and type an alpha character, such as c, p, or n, at which you want the list of note titles to begin.
4. In the Description box, enter comments to describe the procedure.
5. Select the **Require External Data** check box for the procedure to allow external attachments.

   **General**

<table>
<thead>
<tr>
<th>Treating Specialty:</th>
<th>Hospital Location:</th>
<th>TIU Note Title:</th>
</tr>
</thead>
<tbody>
<tr>
<td>CARDIAC INTENSIVE CARE U/A</td>
<td>CT CLINIC</td>
<td>PFT &lt;CP PFT&gt;</td>
</tr>
</tbody>
</table>

   Description:
   Colonoscopy

   External Attachment Directory:
   \{medserv\}colonoscopy

   - [X] Require External Data
   - [X] Auto Submit To VistA Imaging
   - [ ] High Volume Instrument
   - [X] Active

   Processing Application:
   - [X] Default (CP)
   - [ ] Hemodialysis

   Processed Results:
   - [X] Final Result
   - [ ] Multiple Results
   - [ ] Cumulative Result

   **Figure 6-26, Procedure Worksheet**

6. If you select the **Require External Data** check box, enter the path to the location of the data, or browse to locate a directory in the **External Attachment Directory** field.

7. Select the **Auto Submit to VistA Imaging** check box to automatically submit the study to VistA Imaging.

8. Select the **High Volume Instrument** check box for a frequently used instrument.

9. To make the procedure available in CP Flowsheets, select the **Active** check box.

10. From the Processing Application options, select either **Default (CP)** or **Hemodialysis**.

11. From the Processed Results options, select one: **Final Result**, **Multiple Results**, or **Cumulative Result**.
6.6.6. Adding Allowable Instruments

To add instruments for a procedure:

1. From the Allowable Instruments list, select all instruments that provide results for the procedure.

<table>
<thead>
<tr>
<th>Allowable Instruments</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Athena Hypertension - Athena Hypertension Device Interface</td>
</tr>
<tr>
<td>✔ □ AWARE - New Instrument</td>
</tr>
<tr>
<td>□ AWARE - New Instrument</td>
</tr>
<tr>
<td>□ AWARE - GE AWARE Gateway</td>
</tr>
</tbody>
</table>

![Figure 6-27, Allowable Instruments](image)

2. Click Save.
This page intentionally left blank for double-sided printing.
7. Shortcut Keys

When you first open CP Console, you can use Tab and the arrow keys to maneuver through the main window.

The following is a list of shortcut keys for the CP Console main window.

<table>
<thead>
<tr>
<th>Option/Text</th>
<th>Shortcut</th>
<th>Action/Opens</th>
</tr>
</thead>
<tbody>
<tr>
<td>File menu</td>
<td>Alt, F</td>
<td>Sets up for shortcuts</td>
</tr>
<tr>
<td>New</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Flowsheet</td>
<td>F</td>
<td></td>
</tr>
<tr>
<td>Flowsheet Total</td>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Flowsheet View</td>
<td>L</td>
<td></td>
</tr>
<tr>
<td>Instrument</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>Procedure</td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Schedule</td>
<td>C</td>
<td></td>
</tr>
<tr>
<td>Shift</td>
<td>S</td>
<td></td>
</tr>
<tr>
<td>Rename</td>
<td>R</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td>D</td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td>S</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>Tools menu</td>
<td>Alt, T</td>
<td>Opens the Tools menu</td>
</tr>
<tr>
<td>Search</td>
<td>S</td>
<td></td>
</tr>
<tr>
<td>Permissions</td>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Refresh Roles</td>
<td>R</td>
<td></td>
</tr>
<tr>
<td>Export To XML</td>
<td>E</td>
<td></td>
</tr>
<tr>
<td>Import From XML</td>
<td>I</td>
<td></td>
</tr>
<tr>
<td>Help menu</td>
<td>Alt, H</td>
<td>Opens the Help menu</td>
</tr>
<tr>
<td>About</td>
<td>A</td>
<td>Application information</td>
</tr>
<tr>
<td>Contents</td>
<td>C</td>
<td>Online help</td>
</tr>
</tbody>
</table>
# 8. Glossary

This glossary is used for the Clinical Flowsheets project and may include terms and definitions not used in this specific document.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;RET&gt;</td>
<td>Carriage return.</td>
</tr>
<tr>
<td>Access Code</td>
<td>A unique sequence of characters known by and assigned only to the user, the system manager and/or designated alternate(s). The access code (in conjunction with the verify code) is used by the computer to identify authorized users.</td>
</tr>
<tr>
<td>Action</td>
<td>A functional process that a clinician or clerk uses in the TIU computer program. For example, “Edit” and “Search” are actions. Protocol is another name for Action.</td>
</tr>
<tr>
<td>ADP</td>
<td>Automated Data Processing</td>
</tr>
<tr>
<td>ADP Coordinator/ADPAC/Application Coordinator</td>
<td>Automated Data Processing Application Coordinator. The person responsible for implementing a set of computer programs (application package) developed to support a specific functional area such as clinical procedures, PIMS, etc.</td>
</tr>
<tr>
<td>ADT</td>
<td>Advanced Data Type (InterSystems Cache). Also Admissions, Discharges, Transfers.</td>
</tr>
<tr>
<td>AP</td>
<td>Arterial pressure</td>
</tr>
<tr>
<td>API</td>
<td>Application Programming Interface. An interface that a computer system, library, or application provides in order to accept requests for services from other programs, and/or to allow data to be exchanged between them.</td>
</tr>
<tr>
<td>Application</td>
<td>A system of computer programs and files that have been specifically developed to meet the requirements of a user or group of users.</td>
</tr>
<tr>
<td>Archive</td>
<td>The process of moving data to some other storage medium, usually a magnetic tape, and deleting the information from active storage in order to free-up disk space on the system.</td>
</tr>
<tr>
<td>Assessment</td>
<td>Assessment is the documentation of a clinician’s observations and interpretation of a patient’s clinical state based on a particular set of observations. The documentation is in the form of name-value pairs with values selected from a predetermined set, of name-value pairs in which the value is a number or set of numbers, or of free text. Examples of assessments from paper ICU flowsheets are coma scale, patient opens eyes, pupil size, reaction to light, and so on.</td>
</tr>
<tr>
<td>ASU</td>
<td>Authorization/Subscription Utility. An application that allows sites to associate users with user classes, allowing them to specify the level of authorization needed to sign or order specific document types and orderables. ASU is distributed with TIU in this version; eventually it will probably become independent, to be used by many VistA packages.</td>
</tr>
<tr>
<td>Attachments</td>
<td>Attachments are files or images stored on a network share that can be linked to the CP study. CP is able to accept data/final result report files from automated instruments. The file types that can be used as attachments are the following: .txt - Text files .rtf - Rich text files .jpg - JPEG Images .jpeg - JPEG Images .bmp - Bitmap Images .tiff - TIFF Graphics (group 3 and group 4 compressed and uncompressed types) .pdf - Portable Document Format .html - Hypertext Markup Language .DOC (Microsoft Word) files are not supported. Be sure to convert .doc files to .rtf or to .pdf format.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Background Processing</strong></td>
<td>Simultaneous running of a &quot;job&quot; on a computer while working on another job. Examples would be printing of a document while working on another, or the software might do automatic saves while you are working on something else.</td>
</tr>
<tr>
<td><strong>Background Task</strong></td>
<td>A job running on a computer while simultaneously working on a second job.</td>
</tr>
<tr>
<td><strong>Backup Procedures</strong></td>
<td>The provisions made for the recovery of data files and program libraries and for restart or replacement of ADP equipment after the occurrence of a system failure.</td>
</tr>
<tr>
<td><strong>Boilerplate Text</strong></td>
<td>A pre-defined TIU template that can be filled in for Titles, Speeding up the entry process. TIU exports several Titles with boilerplate text which can be modified to meet specific needs; sites can also create their own.</td>
</tr>
<tr>
<td><strong>BP</strong></td>
<td>Blood Pressure.</td>
</tr>
<tr>
<td><strong>Broker</strong></td>
<td>Software which mediates between two objects, such as a client and a server or a repository and a requestor.</td>
</tr>
<tr>
<td><strong>Browse</strong></td>
<td>Lookup the file folder for a file that you would like to select and attach to the study. (e.g., clicking the “...” button to start a lookup).</td>
</tr>
<tr>
<td><strong>Bulletin</strong></td>
<td>A canned message that is automatically sent by MailMan to a user when something happens to the database.</td>
</tr>
<tr>
<td><strong>Business Rule</strong></td>
<td>Part of ASU, Business Rules authorize specific users or groups of users to perform specified actions on documents in particular statuses (e.g., an unsigned CP note may be edited by a provider who is also the expected signer of the note).</td>
</tr>
<tr>
<td><strong>CAC</strong></td>
<td>Clinical Application Coordinator.</td>
</tr>
<tr>
<td><strong>Care Action</strong></td>
<td>Care action is an intervention scheduled on a patient that may or may not be ordered.</td>
</tr>
<tr>
<td><strong>CCB</strong></td>
<td>Change Control Board.</td>
</tr>
<tr>
<td><strong>CCDSS</strong></td>
<td>Clinical Care Delivery Support System.</td>
</tr>
<tr>
<td><strong>CCOW</strong></td>
<td>Clinical Context Object Workgroup. An HL7 standard protocol through which applications can synchronize in real-time, enabling Single Sign On and Context Management.</td>
</tr>
<tr>
<td><strong>CDR</strong></td>
<td>Clinical Data Repository.</td>
</tr>
<tr>
<td><strong>CIS</strong></td>
<td>Clinical Information System. An ICU Clinical Information System is any hardware/software system that works in concert to collect, store, display, and/or enable manipulation of potential, clinically relevant information. A CIS also acts as an HL7 Gateway. Vendors of monitors and other instruments used in an ICU provide the CIS. The primary distinguishing feature of this CIS is its ability to manually select a subset of all available data and send it to the EMR.</td>
</tr>
<tr>
<td><strong>Class</strong></td>
<td>Part of Document Definitions, Classes group documents. For example, “CLINICAL PROCEDURES” is a class with many kinds of Clinical Procedures notes under it. Classes may be subdivided into other Classes or Document Classes. Besides grouping documents, Classes also store behavior which is then inherited by lower level entries.</td>
</tr>
<tr>
<td><strong>Clinical Flowsheets</strong></td>
<td>A module of the Clinical Procedures package that allows the collection of discrete data from medical devices or a Clinical Information System. It is a complete HL7 standardized instrument interface developed and owned by the Department of Veterans Affairs. This module is comprised of three components: the CP Flowsheets application, the CP Console application, and the CliO Generic Interface.</td>
</tr>
<tr>
<td><strong>Clinical Reminders</strong></td>
<td>A system which allows caregivers to track and improve preventive healthcare and disease treatment for patients and to ensure timely clinical interventions.</td>
</tr>
<tr>
<td>** CliO**</td>
<td>Clinical Observations database.</td>
</tr>
<tr>
<td><strong>CM</strong></td>
<td>Configuration Management.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Consult</td>
<td>Referral of a patient by the primary care physician to another hospital service/specialty, to obtain a medical opinion based on patient evaluation and completion of any procedures, modalities, or treatments the consulting specialist deems necessary to render a medical opinion.</td>
</tr>
<tr>
<td>Contingency Plan</td>
<td>A plan that assigns responsibility and defines procedures for use of the backup/restart/recovery and emergency preparedness procedures selected for the computer system based on risk analysis for that system.</td>
</tr>
<tr>
<td>CP</td>
<td>Clinical Procedures.</td>
</tr>
<tr>
<td>CP Console</td>
<td>An application used by Administrators to configure the CP Flowsheets application and its interface settings.</td>
</tr>
<tr>
<td>CP Definition</td>
<td>CP Definitions are procedures within Clinical Procedures.</td>
</tr>
<tr>
<td>CP Flowsheets</td>
<td>A GUI component of the Clinical Flowsheets package. Its primary functions are to provide a means to display data collected from a medical device and to allow manual entry of data. Additional functionality is provided to display and print reports, verify incoming observational data, add comments, correct erroneous information, and submit TIU Notes to CPRS.</td>
</tr>
<tr>
<td>CP Gateway</td>
<td>The service application that prepares the data contents of HL7 messages for use in CP Hemodialysis. It requires no direct user interaction.</td>
</tr>
<tr>
<td>CP Manager</td>
<td>The CP Manager application is no longer supported after the installation of MD<em>1.0</em>16; it has been superseded by CP Console.</td>
</tr>
<tr>
<td>CP Study</td>
<td>A CP study is a process created to link the procedure result from the medical device or to link the attachments browsed from a network share to the procedure order.</td>
</tr>
<tr>
<td>CPRS</td>
<td>Computerized Patient Record System. A comprehensive VistA program, which allows clinicians and others to enter and view orders, Progress Notes and Discharge Summaries (through a link with TIU), Problem List, view results, reports (including health summaries), etc.</td>
</tr>
<tr>
<td>Data Dictionary</td>
<td>A description of file structure and data elements within a file.</td>
</tr>
<tr>
<td>DBIA</td>
<td>Database Integration Agreement.</td>
</tr>
<tr>
<td>Delphi</td>
<td>A programming language, also known as Object Pascal.</td>
</tr>
<tr>
<td>Device</td>
<td>A hardware input/output component of a computer system (e.g., CRT, printer).</td>
</tr>
<tr>
<td>Display Interval</td>
<td>The amount of time that displays in each column of a flowsheet view. Display interval is configurable from 1 minute to 24 hours. Shorter interval settings can improve readability when a large amount of data is received over a short period of time. Longer interval settings allow you to view longer periods of time while reducing the amount of horizontal scrolling necessary to view all columns.</td>
</tr>
<tr>
<td>DLL</td>
<td>Dynamically Linked Library. These files provide the benefit of shared libraries.</td>
</tr>
<tr>
<td>DOB</td>
<td>Date of Birth.</td>
</tr>
<tr>
<td>Document Class</td>
<td>Document Classes are categories that group documents (Titles) with similar characteristics together. For example, Cardiology notes might be a Document Class, with Echo notes, ECG notes, etc. as Titles under it. Or maybe the Document Class would be Endoscopy Notes, with Colonoscopy notes, etc. under that Document Class.</td>
</tr>
<tr>
<td>Document Definition</td>
<td>Document Definition is a subset of TIU that provides the building blocks for TIU, by organizing the elements of documents into a hierarchy structure. This structure allows documents (Titles) to inherit characteristics (such as signature requirements and print characteristics) of the higher levels, Class and Document Class. It also allows the creation and use of boilerplate text and embedded objects.</td>
</tr>
<tr>
<td>DUZ</td>
<td>Designated user. This is the internal FileMan number for a particular user.</td>
</tr>
<tr>
<td>Edit</td>
<td>Used to change/modify data typically stored in a file.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EMR</td>
<td>Electronic Medical Record. HealthVet, is the permanent medical record for a patient in VistA</td>
</tr>
<tr>
<td>Field</td>
<td>A data element in a file.</td>
</tr>
<tr>
<td>File</td>
<td>The M construct in which data is stored for retrieval later. A computer record of related information.</td>
</tr>
<tr>
<td>File Manager or FileMan</td>
<td>Within this manual, FileManager or FileMan is a reference to VA FileMan. FileMan is a set of M routines used to enter, edit, print, and sort/search related data in a file, a database.</td>
</tr>
<tr>
<td>File Server</td>
<td>A machine where shared software is stored.</td>
</tr>
<tr>
<td>Flowsheet</td>
<td>A flowsheet is a table, chart, spreadsheet, or other method of displaying data on two axes. One axis represents time intervals and the other axis represents the readings from an ICU monitor documented at the various time intervals.</td>
</tr>
<tr>
<td>Clinical Flowsheet Coordinator</td>
<td>Primary liaison for implementation, maintenance, and evaluation of the CP Flowsheet application at the facility level.</td>
</tr>
<tr>
<td>Flowsheet view</td>
<td>A customizable subsection (or page) of a flowsheet. Flowsheet views are created by adding and arranging terms and choosing their default qualifiers. Flowsheet views can be set up to display observations, provide a way to manually enter observations, and display reports.</td>
</tr>
<tr>
<td>Fluid off</td>
<td>Cumulative volume of fluid removed from patient.</td>
</tr>
<tr>
<td>Gateway</td>
<td>The software that performs background processing for Clinical Procedures.</td>
</tr>
<tr>
<td>Global</td>
<td>An M term used when referring to a file stored on a storage medium, usually a magnetic disk.</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface. A Windows-like screen that uses pull-down menus, icons, pointer devices, and other metaphor-type elements that can make a computer program more understandable, easier to use, allow multi-processing (more than one window or process available at once), etc.</td>
</tr>
<tr>
<td>HDR</td>
<td>Health Data Repository.</td>
</tr>
<tr>
<td>HEP (CUM)</td>
<td>Cumulative heparin infusion</td>
</tr>
<tr>
<td>HFS</td>
<td>Host File System.</td>
</tr>
<tr>
<td>HIPAA</td>
<td>Health Insurance Portability and Accountability Act.</td>
</tr>
<tr>
<td>HL7 Gateway</td>
<td>Hardware or software provided by a vendor that is able to receive information in a vendor’s proprietary format from one or more ICU monitors and other instruments, to translate the data into standardized HL7 message format, and to pass the messages to other systems.</td>
</tr>
<tr>
<td>HR</td>
<td>Heart Rate.</td>
</tr>
<tr>
<td>HSD&amp;D</td>
<td>Office of Information (OI), Health Systems Design &amp; Development.</td>
</tr>
<tr>
<td>ICU</td>
<td>Intensive Care Unit.</td>
</tr>
<tr>
<td>IEN</td>
<td>Internal Entry Number.</td>
</tr>
<tr>
<td>IJ</td>
<td>Internal Jugular.</td>
</tr>
<tr>
<td>Instrument</td>
<td>An instrument is a device used to perform a medical function on a patient. In Clinical Flowsheets instrument refers to ICU monitors, which are electronic devices that collect and/or display information concerning the physical state of a patient. Usually, the monitor attaches to a patient and takes readings over time without requiring intervention for each reading.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Interpreter</td>
<td>Interpreter is a user role exported with USR<em>1</em>19 to support the Clinical Procedures Class. The role of the Interpreter is to interpret the results of a clinical procedure. Users who are authorized to interpret the results of a clinical procedure are sent a notification when an instrument report and/or images for a CP request are available for interpretation. Business rules are used to determine what actions an interpreter can perform on a document of a specified class, but the interpreter themselves are defined by the Consults application. These individuals are ‘clinical update users’ for a given consult service.</td>
</tr>
<tr>
<td>IRM</td>
<td>Information Resource Management.</td>
</tr>
<tr>
<td>JCAHO</td>
<td>Joint Commission on Accreditation of Healthcare Organizations.</td>
</tr>
<tr>
<td>Kernel</td>
<td>A set of software utilities. These utilities provide data processing support for the application packages developed within the VA. They are also tools used in configuring the local computer site to meet the particular needs of the hospital. The components of this operating system include MenuMan, TaskMan, Device Handler, Log-on/Security, and other specialized routines.</td>
</tr>
<tr>
<td>Key</td>
<td>A level of access assigned to a Flowsheets user that determines which Flowsheets functions the user may perform. Refer to “User Role” in this Glossary.</td>
</tr>
<tr>
<td>LAYGO</td>
<td>An acronym for Learn As You Go. A technique used by VA FileMan to acquire new information as it goes about its normal procedure. It permits a user to add new data to a file.</td>
</tr>
<tr>
<td>Log</td>
<td>A list that provides the time and description of events as they occur.</td>
</tr>
<tr>
<td>M</td>
<td>Formerly known as MUMPS or the Massachusetts (General Hospital) Utility Multi-Programming System. This is the programming language used to write all VistA applications.</td>
</tr>
<tr>
<td>MailMan</td>
<td>An electronic mail, teleconferencing, and networking system.</td>
</tr>
<tr>
<td>MAP</td>
<td>Mean Arterial Pressure.</td>
</tr>
<tr>
<td>Menu</td>
<td>A set of options or functions available to users for editing, formatting, generating reports, etc.</td>
</tr>
<tr>
<td>Module</td>
<td>A component of a software application that covers a single topic or a small section of a broad topic.</td>
</tr>
<tr>
<td>MUMPS</td>
<td>Massachusetts General Hospital Utility Multi-Programming System. Obsolete; now known as &quot;M&quot; programming language.</td>
</tr>
<tr>
<td>Namespace</td>
<td>A naming convention followed in the VA to identify various applications and to avoid duplication. It is used as a prefix for all routines and globals used by the application.</td>
</tr>
<tr>
<td>Network Server Share</td>
<td>A machine that is located on the network where shared files are stored.</td>
</tr>
<tr>
<td>Notebook</td>
<td>This term refers to a GUI screen containing several tabs or pages.</td>
</tr>
<tr>
<td>NTE</td>
<td>Not To Exceed.</td>
</tr>
<tr>
<td>option</td>
<td>A functionality that is invoked by the user. The information defined in the option is used to drive the menu system. Options are created, associated with others on menus, or given entry/exit actions.</td>
</tr>
<tr>
<td>optional page</td>
<td>One of two special types of flowsheet views which provides a way to track a specific condition (e.g., a pacemaker) on its own flowsheet view. An Optional Page can display only once in a given flowsheet. If an optional page is closed and then redisplayed, any data previously entered still displays.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Package</td>
<td>Otherwise known as an application. A set of M routines, files, documentation and installation procedures that support a specific function within VistA.</td>
</tr>
<tr>
<td>page</td>
<td>This term refers to a tab on a GUI screen or notebook.</td>
</tr>
<tr>
<td>Password</td>
<td>A protected word or string of characters that identifies or authenticates a user, a specific resource, or an access type (synonymous with Verify Code).</td>
</tr>
<tr>
<td>PCE</td>
<td>Patient Care Encounter.</td>
</tr>
<tr>
<td>PD</td>
<td>Product Development</td>
</tr>
<tr>
<td>Permission</td>
<td>Setting that can be used to allow access to particular views, flowsheets, etc. to one or more specific users and to control the type of access each user has.</td>
</tr>
<tr>
<td>PIMS</td>
<td>Patient Information Management System.</td>
</tr>
<tr>
<td>Pivot</td>
<td>Swap the axes of a table or chart. This causes the values that were displayed along the vertical axis to be displayed along the horizontal axis and the values that were displayed along the horizontal axis to be displayed along the vertical axis.</td>
</tr>
<tr>
<td>PM</td>
<td>Project Manager.</td>
</tr>
<tr>
<td>Pointer</td>
<td>A special data type of VA FileMan that takes its value from another file. This is a method of joining files together and avoiding duplication of information.</td>
</tr>
<tr>
<td>PRN</td>
<td>As needed.</td>
</tr>
<tr>
<td>Procedure Request</td>
<td>Any procedure (EKG, Stress Test, etc.) which may be ordered from another service/specialty without first requiring formal consultation.</td>
</tr>
<tr>
<td>Program</td>
<td>A set of M commands and arguments, created, stored, and retrieved as a single unit in M.</td>
</tr>
<tr>
<td>Protocol</td>
<td>A set of rules governing communication within and between computing endpoints.</td>
</tr>
<tr>
<td>PS</td>
<td>Provider Systems.</td>
</tr>
<tr>
<td>PV</td>
<td>Pulmonary Vascular.</td>
</tr>
<tr>
<td>QG</td>
<td>Quality Gate.</td>
</tr>
<tr>
<td>Qualifiers</td>
<td>A word or phrase that provides specific information about an observation. For example, an observation could have qualifiers such as Unit (f=degrees Fahrenheit, c=degrees Celsius, bpm=beats per minute, rpm=respirations per minute, etc.), Method (Cu=cuff BP, Dop=Doppler BP, etc.), Position (Ly=lying, Si=sitting, St=standing, etc.), Location (La=left arm, LL=left leg, RA=right arm, RL=right leg, etc.), Quality (A=accurate, E=Estimated), etc.</td>
</tr>
<tr>
<td>Queuing</td>
<td>The scheduling of a process/task to occur later. Queuing is normally done if a task is a heavy user of computer resources.</td>
</tr>
<tr>
<td>RAID</td>
<td>Redundant Array of Inexpensive Disks. A data storage scheme using multiple hard drives to share or replicate data among the drives.</td>
</tr>
<tr>
<td>Result</td>
<td>A consequence of an order. Refers to evaluation or status results. When you use the Complete Request (CT) action on a consult or request, you are transferred to TIU to enter the results.</td>
</tr>
<tr>
<td>Routine</td>
<td>A set of M commands and arguments, created, stored, and retrieved as a single unit in M.</td>
</tr>
<tr>
<td>RPC</td>
<td>Remote Procedure Call. A protocol that allows a computer program running on one host to cause code to be executed on another host.</td>
</tr>
<tr>
<td>Rx</td>
<td>Prescription.</td>
</tr>
<tr>
<td>SAC</td>
<td>Standards And Conventions.</td>
</tr>
<tr>
<td>Security Key</td>
<td>A function which unlocks specific options and makes them accessible to an authorized user.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sensitive Information</td>
<td>Any information which requires a degree of protection and which should be made available only to authorized users.</td>
</tr>
<tr>
<td>Service</td>
<td>A long-running executable designed to perform specific functions without user intervention. Windows services can be configured to restart automatically when the operating system is rebooted.</td>
</tr>
<tr>
<td>SGML</td>
<td>Standard Generalized Markup Language.</td>
</tr>
<tr>
<td>Shift</td>
<td>A period of time that can be defined in CP Flowsheets. This often corresponds to the time an individual an individual works.</td>
</tr>
<tr>
<td>Site Configurable</td>
<td>A term used to refer to features in the system that can be modified to meet the needs of each site.</td>
</tr>
<tr>
<td>Software</td>
<td>A generic term for a related set of computer programs, such as an operating system that enables user programs to run.</td>
</tr>
<tr>
<td>SQA</td>
<td>Software Quality Assurance.</td>
</tr>
<tr>
<td>SRS</td>
<td>Software Requirements Specification.</td>
</tr>
<tr>
<td>SSN</td>
<td>Social Security Number.</td>
</tr>
<tr>
<td>Status Symbols</td>
<td>Codes used in order entry and Consults displays to designate the status of the order.</td>
</tr>
<tr>
<td>STS</td>
<td>Standards and Terminology Services. An initiative to create and maintain standardized terminology throughout the VA by assigning a code to every term.</td>
</tr>
<tr>
<td>Supplemental page</td>
<td>One of two special types of flowsheet views which provides a way to track a specific condition (e.g., a pressure wound) on its own flowsheet view. Multiple supplemental pages can be added to a single flowsheet in order to track numerous specific conditions. If a supplemental page is closed and then a new supplemental page is added, the new supplemental page is blank.</td>
</tr>
<tr>
<td>Tab</td>
<td>One of the five primary GUI screens of the CP Flowsheets application: Flowsheet, Alarms, Reports, Log Files, and HL7 Monitor.</td>
</tr>
<tr>
<td>Task Manager or TaskMan</td>
<td>A part of Kernel which allows programs or functions to begin at specified times or when devices become available. See Queuing.</td>
</tr>
<tr>
<td>Term</td>
<td>As used in Flowsheets, a term is any piece of relevant data. A term, like “Blood Pressure” will typically have one or more associated measures, modifiers, or qualifiers.</td>
</tr>
<tr>
<td>Terminology</td>
<td>Standardization of words and terms used in Flowsheets.</td>
</tr>
<tr>
<td>Title</td>
<td>Titles are definitions for documents. They store the behavior of the documents which use them.</td>
</tr>
<tr>
<td>TIU</td>
<td>Text Integration Utilities.</td>
</tr>
<tr>
<td>TMP</td>
<td>Trans Membrane Pressure.</td>
</tr>
<tr>
<td>UFR</td>
<td>Ultrafiltration Rate.</td>
</tr>
<tr>
<td>UI</td>
<td>User Interface.</td>
</tr>
<tr>
<td>UNC</td>
<td>Universal Naming Convention.</td>
</tr>
<tr>
<td>Untrusted device</td>
<td>A medical instrument which has not been mapped for use with the Clinical Flowsheets package. Data sent from an untrusted device will not display in a flowsheet view until someone reviews it (on the CP Flowsheets Log Files tab) and marks it as verified.</td>
</tr>
<tr>
<td>URL</td>
<td>Uniform Resource Locator. A means of finding a resource (such as a web page or a device) on the Internet.</td>
</tr>
<tr>
<td>URR</td>
<td>Urea Reduction Ratio. The reduction in urea as a result of dialysis.</td>
</tr>
<tr>
<td>User</td>
<td>A person who enters and/or retrieves data in a system, usually utilizing a CRT.</td>
</tr>
<tr>
<td>Term</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User Class</td>
<td>User Classes are the basic components of the User Class hierarchy of ASU (Authorization/Subscription Utility) which allows sites to designate who is authorized to do what to documents or other clinical entities.</td>
</tr>
<tr>
<td>User Role</td>
<td>User Role (in a documentation context). The role of the user with respect to the document in question (e.g., Author/Dictator, Expected Signer, Expected Cosigner, Attending Physician, etc.).</td>
</tr>
</tbody>
</table>
| User Role        | User Role (in a Flowsheets setup context). The role of a Flowsheets user with respect to which Flowsheets functions the user will have permission to perform. Flowsheets User Role include the following.  
• MD ADMINISTRATOR  
• MD MANAGER  
• MD HL7 MANAGER  
• MD READ-ONLY  
• MD TRAINEE |
| Utility          | An M program that assists in the development and/or maintenance of a computer system.                                                                 |
| UUEncoded format | A form of binary to text encoding whose name derives from "Unix-to-Unix encoding".                                                                 |
| VA               | Department of Veterans Affairs. Formerly the Veterans Administration.                                                                                                                   |
| VAMC             | Department of Veterans Affairs Medical Center.                                                                                                                                             |
| VDEF             | VistA Data Extraction Framework.                                                                                                                                                    |
| Verify Code      | A unique security code which serves as a second level of security access. Use of this code is site specific. This term is sometimes used interchangeably the term password.            |
| VHA              | Veteran Health Administration.                                                                                                                                                           |
| VistA            | Veterans Health Information Systems and Technology Architecture.                                                                                                                         |
| VP               | Venous Pressure.                                                                                                                                                                          |
| VUID             | Veterans Health Administration (VHA) Unique Identifier. A unique identifier that specifies individual data elements or observations. In Clinical Flowsheets, each term is assigned a VUID.       |
| Workstation      | A personal computer running the Windows 9x or NT operating system.                                                                                                                     |
| XML              | Extensible Markup Language. A simplified subset of Standard Generalized Markup Language (SGML). Its primary purpose is to facilitate the sharing of data across different information systems. |
| XMS              | Extended Memory Specification. The specification describing the use of extended memory in real mode for storing data.                                                                   |
Index

A

About ............................................................... 19
Access Control List Manager ........................... 12
Add a Procedure ............................................... 72
Add a Shift ....................................................... 54
Add a View to a Flowsheet .............................. 44
Add an ADT Target ......................................... 68
Add an Instrument ............................................ 59
Add Terms to a View ....................................... 35
Add Terms to Flowsheet Totals ....................... 50
Add Totals to a Flowsheet ............................... 51

B

Background Task
  CliO cleanup ................................................ 58
  CP cleanup ................................................... 58
  HL7 cleanup ................................................. 58
  Name ............................................................ 57
  Scheduled ..................................................... 57
  Status ............................................................ 57
  Task ID ......................................................... 57

C

Change the Display Order of Terms ..............50
Change the Display Order of Terms in a View38
Change the Display Order of Totals in a
  Flowsheet ..................................................... 52
Change the Display Order of Views in a
  Flowsheet ..................................................... 47
CliO Database .................................................... 2
Contents ........................................................... 19
CP ADT Feed Configuration
  Add ADT target ........................................... 68
  Current ADT targets ................................. 68
CP Console ...................................................... 3
CP Console Button Bar
  Permissions ............................................... 12
CP Console Detail Area ................................. 20
CP Console Functionality
  Creating a flowsheet total ......................... 48
  Creating a flowsheet view ......................... 32
CP Console Menu Bar ...................................... 8
  File menu ................................................... 8
  Help menu .................................................. 19
CP Console Tree View .................................... 19
  Flowsheet total .......................................... 52
  Parameters ................................................... 60
  Procedure .................................................. 71
CP Flowsheets ................................................ 71
CP Gateway ...................................................... 3
CP Gateway Configuration
  Gateway server settings ............................ 70
  VistA server settings ................................. 70
CP Gateway Service ........................................ 1
CP Parameters
  Allow CliO cached queries ....................... 67
  Allow external attachments .................... 66, 67
  Bypass CRC check ...................................... 67
  Clinical procedures system on line ............ 67
  CP common parameter set ........................... 66
  Imaging network transfer directory ............ 66, 67
  Instrument data retention ........................ 67
  Observation retrieval batch size ............... 66
  Unverified observation retention ............... 67

Creating a Flowsheet
  Adding a view .............................................. 44
  Adding totals to a flowsheet ..................... 51
  Changing the display order of totals .......... 52
  Changing the display order of view ............ 47
  Editing a view .............................................. 46
  Pages tab .................................................... 45
  Removing a view .......................................... 47
  Removing totals from a flowsheet ............... 52

Creating a Flowsheet Total
  Adding terms ............................................... 50
  Changing the display order of terms .......... 50
  Removing terms ........................................... 50

Creating a Flowsheet View
  Adding terms to a view ................................ 35
  Changing the display order of terms .......... 38
  Editing terms in a view ............................... 38
  Removing terms from a view ...................... 40

D

Delete an Item.................................................... 10

E

Edit a View in a Flowsheet ......................... 46
Edit Terms in a View ....................................... 38
Exit ............................................................. 11
Export To XML ............................................... 15
F

File Menu
- Deleting an item ........................................... 10
- Exit ............................................................... 11
- New .............................................................. 9
- Renaming an item ........................................ 10
- Save .............................................................. 11

Flowsheet View
- Time interval ................................................ 33

Flowsheet
- Adding a view .............................................. 44
- Adding totals ................................................ 51
- Changing display order of views ..................... 47
- Changing the display order of totals ................. 52
- Editing a view .............................................. 46
- Removing a view ......................................... 47
- Removing totals ........................................... 52

Flowsheet Total ................................................ 52
- Adding terms ................................................ 50
- Changing the display order of terms ................. 50
- Create ........................................................... 48
- Decimals ...................................................... 53
- Default unit .................................................. 53
- Display properties ........................................ 53
- Removing terms ........................................... 50

Flowsheet View
- Adding terms ................................................ 35
- Allow pivot .................................................. 33
- Changing display order of terms ..................... 38
- Create ........................................................... 32
- Editing terms ................................................ 38
- Qualifiers ...................................................... 37
- Removing terms ........................................... 40
- Terminology ................................................. 34
- Terminology editor ...................................... 34
- X-Axis .......................................................... 33

G

Gateway Server Settings
- CP/imaging xfer directory ............................ 71
- Days to retain data ........................................ 71
- Log directory ............................................... 71
- Log level ..................................................... 70
- Notify port ................................................... 70
- Polling interval ............................................ 71

Procedure
- Add .............................................................. 71
- Allowable instruments ................................... 72
- Auto submit to VistA imaging ....................... 77
- External attachment directory ....................... 76
- High volume instrument .............................. 76
- Hospital location ......................................... 76
- Modifying existing ....................................... 73
- Processed results ....................................... 77
- Processing application ............................... 77
- Require external data ................................... 76
- TIU note title .............................................. 76

H

Help Menu

About .................................................................. 19
Contents ........................................................ 19

I

Instrument
- Add .............................................................. 59
- Default file extension .................................... 63
- Delete when submitted ................................. 63
- HL7 instrument ID ......................................... 64
- HL7 link ....................................................... 63
- HL7 universal service ID ............................... 64
- IP address ..................................................... 64
- M routine ..................................................... 63
- Pkg code ..................................................... 63
- Port ............................................................... 64
- Serial number ............................................. 62
- Valid attachment types ................................ 63

K

Key
- MD ADMINISTRATOR .................................. 14
- MD MANAGER ............................................ 14

M

Modify an Existing Procedure ......................... 73
Modify an Existing Shift ................................. 55

N

New ............................................................... 9

P

Parameters ....................................................... 60
- Adding an ADT target ................................... 68
- CP ADT feed configuration .......................... 67
- CP gateway configuration ............................ 69
- CP parameters ............................................. 65

Permissions ..................................................... 12
- Access control list manager ......................... 12

Procedure ......................................................... 71
- Add .............................................................. 71
- Allowable instruments ................................... 72
- Auto submit to VistA imaging ....................... 77
- External attachment directory ....................... 76
- High volume instrument .............................. 76
- Hospital location ......................................... 76
- Modifying existing ....................................... 73
- Processed results ....................................... 77
- Processing application ............................... 77
- Require external data ................................... 76
- TIU note title .............................................. 76

March 2016 Clinical Flow Sheet CliO V2 Implementation Guide
<table>
<thead>
<tr>
<th>R</th>
<th>Refresh Roles ........................................... 12, 14</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Remove a View from a Flowsheet................. 47</td>
</tr>
<tr>
<td></td>
<td>Remove Terms from a View ............................ 40</td>
</tr>
<tr>
<td></td>
<td>Remove Terms from Flowsheet Totals ............ 50</td>
</tr>
<tr>
<td></td>
<td>Remove Totals from a Flowsheet .......... 52</td>
</tr>
<tr>
<td></td>
<td>Rename .................................................... 28</td>
</tr>
<tr>
<td></td>
<td>Rename an Item ........................................... 10</td>
</tr>
<tr>
<td>S</td>
<td>Save.................................................................. 11</td>
</tr>
<tr>
<td></td>
<td>Search........................................................ 11</td>
</tr>
<tr>
<td></td>
<td>Shift</td>
</tr>
<tr>
<td></td>
<td>Add.................................................................. 54</td>
</tr>
<tr>
<td></td>
<td>Modifing existing........................................ 55</td>
</tr>
<tr>
<td></td>
<td>Start time.................................................. 54</td>
</tr>
<tr>
<td></td>
<td>Stop time.................................................... 54</td>
</tr>
<tr>
<td>T</td>
<td>Terminology ................................................ 34</td>
</tr>
<tr>
<td></td>
<td>Terminology Editor ....................................... 34</td>
</tr>
<tr>
<td></td>
<td>Default unit................................................ 36</td>
</tr>
<tr>
<td></td>
<td>Display columns .......................................... 37</td>
</tr>
<tr>
<td></td>
<td>Display only................................................ 37</td>
</tr>
<tr>
<td></td>
<td>Display width.............................................. 37</td>
</tr>
<tr>
<td></td>
<td>Qualifiers .................................................. 37</td>
</tr>
<tr>
<td></td>
<td>Use dropdown............................................... 37</td>
</tr>
<tr>
<td></td>
<td>Terminology Mapping ....................................... 2</td>
</tr>
<tr>
<td></td>
<td>Tools Menu</td>
</tr>
<tr>
<td></td>
<td>Export to XML ............................................. 16, 17, 18, 24, 26</td>
</tr>
<tr>
<td></td>
<td>Refresh roles............................................ 14</td>
</tr>
<tr>
<td></td>
<td>Search ................................................................ 11</td>
</tr>
<tr>
<td>V</td>
<td>VistA Server Settings</td>
</tr>
<tr>
<td></td>
<td>IP address.................................................. 70</td>
</tr>
<tr>
<td></td>
<td>RPC broker port............................................ 70</td>
</tr>
</tbody>
</table>